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Getting Started 

Requirements 

In order to run IFM 2015, the following are required. 

 High speed internet connection 

 Java 2 Runtime Environment, version 7u25 

 An internet browser (IE10, 11 or latest Firefox or Google Chrome are recommended) 

 1G of physical RAM available for IFM 

 1280 x 1024 resolution or greater (recommended) 

 

Running IFM 

IFM can be accessed through a specified URL. A file will automatically download and run on your computer. The 

up-to-date links can be found at: http://forestry.alaska.gov/integratedmanagement.htm 

On the login screen as shown in Figure 1, enter your IDIR username and password to log in. 

  

Setting up IFM 

There are a few things that new users need to do to get started in IFM: 

1. Select User Preference Location. File > User Preferences > Choose base or office > Save.  See Appendix 5 

for more information. 

2. Select Beeping options. Beeping > IA Request > Everywhere. See Beeping section for more information.  

3. Map Engine:  

a. Choose zoom level (scale) and area for your default map 

b. Choose map layers that you would like enabled on your default map and hit Apply. See Map 

Area section for more information 

4. Icon overlays: 

a. Choose basic icon overlays that you would like enabled on your default map 

b. Some examples are:  

i. Org -> Area Office, Tanker bases 

Figure 1: Logging in to IFM 
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ii. Incidents -> Fire -> Uncontained, Contained, Controlled 

iii. Incidents -> Smoke Reports -> Uncontained 

iv. IA Requests -> Active 

5. Save your own Default map preferences (as selected in step 3 and 4) 

a. File -> Save Map As -> Name your map -> Select 'Load on Start-up' -> Ok 

Using IFM 2015 

Layout of IFM 2015 

 
Figure 2: Layout of IFM 

There are six main parts to the IFM window. These six parts are illustrated in Figure 2. 

 Menu Bar: has the main functions of IFM 
 

Menu Bar 

Map Area 

Toolbar 

Status Bar 

Map Levels 

Icon Overlays 
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 Toolbar: contains many of the functions in the menu bar, and offers shortcuts for the most commonly 
used functions 

 

 Icon Overlays: all of the resources, bases, incidents and other point data that can be displayed over the 
IFM map 

 

 Map Levels: all of the map layers that can be displayed in the Map Area based on the Map Engine 
selected (e.g.: AFS map engine vs. GINA) 

 

 Map Area: the actual map in IFM which displays all of the overlays and map levels that are selected. 
The map is interactive and allows user to click on icons and manipulate the map. 

 

 Status Bar: displays the scale of the current map, the progress indicator when the map is being loaded, 
the coordinates of the position of the mouse in the map area and notifications.  

 
 

1. MENU BAR 
 

 File 
o New:  

This offers access to a new default map, new incident forms, creation of new Resources and 
new general overlays (e.g.: fuel caches). 

o Load Historical Data:  
Allows users to access Incident data for any incidents that occurred before January 1st of this 
year. A pop-up allows the user to select a time range and load incidents on the map and in the 
Incident List. The returned data will always include this year's fire data, even if not selected in 
the range. See Appendix 7 for more information.  

o User Preferences:  
Allows user to indicate which base they are working at, so that certain defaults will be applied 
within IFM (e.g.: creation of new Incident).  
The 'Reset Preferences' button resets to the default settings for IFM (e.g.: form and list 
preferences). See Appendix 5 for more information. 

o Save Map As:  
Saves a map with all of the enabled overlays and map layer preferences, as well as the current 
zoom and map position. See Map Area for more information. 

o Launch Map:  
Opens a previously saved map. See Map Area for more information. 

o Delete Map:  
Deletes an existing saved map. See Map Area for more information. 

o Print Map: 
Prints the current map view. See Map Area for more information. 
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o Export to WFDSS:  
Allows users to export Incident information to WFDSS. The user is prompted for a date range 
and can save a .psv file to upload to WFDSS.  See Appendix 9 for more information.  

o Close/Exit:  
To close the current map, select Close from the File menu. This will close only the specific map 
window if multiple are open. To close all the open map windows and exit IFM, select Exit from 
the File menu or use the X. 
 
 
 

 Lists 
Lists offer access to all data for any of the icons and forms in IFM (e.g.: Incidents, Airports). The Lists can be 

manipulated according to user needs by filtering/searching the list or turning on different columns of 

information or moving columns around.  (Figure 3). 

o List Set-up:   

Lists can be set up to suit user preferences, which are remembered within a session and 

between sessions. The user preferences include: the location of the List on your computer 

monitors, the size of the list form, and users saved lists.   

o Display List Columns:   

Users can configure their lists to display any columns that they wish. To configure the columns, 

click the small arrow  to the right of the column headers. Select or de-select any of the 

options available. (Figure 4).  

o Search within a List:   

Place your cursor in the 'Search Terms Here' field and type text to search by. Hit 'Enter'. The 

search terms are matched against the columns and the List will filter the results. Empty the 

Search text and hit Enter to go back to the full List. 

Figure 4: Select 
column display 

Figure 3: Organization List 
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 The search results will be initially matched on the column that the list is currently being 

sorted on. 

 The search will only happen for columns that are visible (not hidden).   

o Open forms from a List:   

  There are three ways that users can access specific forms from the list.  

 Users can double-click on rows in the lists        OR  

 Highlight the row and hit 'O' on the keyboard (Note: For the Incident, Organization, and 

Resource list, users can also hit ‘L’ to open the log entry form) OR 

 Users can Right-Click and select ‘Open Form’ (Note: The Incident, Organization, and 

Resource list all offer the right-click option to Open Log Note Form and add to Quick 

Picks as well) 

Multiple forms can be opened by holding down CTRL key and clicking. Groups of forms can be 

opened by holding down SHIFT key and clicking. NOTE: only 5 forms can be opened 

simultaneously.  

o Sorting within a List:   

List results can be sorted by clicking on any of the column headers. For example, if you were to 

open 'Resources' and click on the 'Registration' header, the list of resources will sort 

alphabetically on the Registration column. If you were to click on the same header again, it 

would sort in reverse alphabetical order. The columns with numbers will sort in numerical 

order.   

o Filtering a List:   

 Users can filter the list data based on many criteria (eg: List all incidents that are Status = Out). 

Users can choose which fields/columns they would like to use for filtering in order to build 

queries for the list data (eg: Show incidents with Status = Out AND Size = >100ha). 

Different field types have different ways that they can be filtered. Some filters are selection 

check boxes and some are date ranges or number ranges (see Figure 5).  

o  - Choose filters 

o  - Remove the current filters 

o  - Apply the current filters 
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o Saving a List:   

When a user has a manipulated List Settings and/or List Filters they can choose to save that List 

for future use. Saving a List will save both the settings (column selection and order, list size, etc) 

as well as the applied filters.  

o Global Lists:  

An Administrator can set up shared Lists so that all users can use them. These Lists have saved 
settings and filters and can be accessed through the dropdown (beside the Save button). The 
Global Lists have a ~ indicator in front and cannot be edited or deleted by regular users.  

o List Summaries:   

The Resource, Incident and Org lists have Summaries in the panel below the main list. The 

Summaries change based on the filtering or searching applied to the list. For example, if you 

filter on Resource Type: Intermediate, the Summary will show only the Summary information 

for the Intermediate resources. 

o Print List:   

Prints a current list of data within the table/list that is in view. Any columns that are disabled 

will not show in the Printed list. 

o Export to Excel:   

This button exports the list to Excel based on the current filters, sorting, and visible columns. 

The user will be prompted to save the export before opening it in Excel. Any columns that are 

hidden will not export. 

o Collapse all panels:   

Figure 5: Various filter options for the 
Incident list 
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This button collapses the List panels so that the panel headers are all visible and can be 

individually expanded as necessary.  

o Incident Lists:   

 Night Report Required in Lists:  

Incidents are highlighted brown when they require that a Night Report be Completed (active 

fire statuses or called Out within the past day). Once all of the mandatory Night Report fields 

are filled in and the user hits the Complete button in the Night Report panel of the Incident, the 

highlighting goes away.  This is the same for Area Offices in the Organization List. They are 

highlighted in brown until their Costs are submitted each day via the Org form. 

 

 

 

 Tools   

Displays all Toolbar buttons with a few additional pieces of functionality. Select any option in the Tools 

menu to link to that functionality. See the Toolbar section for more information on the various functions as 

well as Dead Reckoning. 

 Beeping   

As a notification to the users, there is an audible beeping for Resources and IA Requests every 15 seconds. 

Resources: beeping occurs when a resource is overdue for a check-in or when they have lost tracking.  

IA Requests: beeping occurs when an IA request is saved with your User Preference in the Responsibility 

field.  

To hear beeping you must ensure: 

1. your computer volume is turned up  

2. the beeping menu -> Everywhere is selected 

3. the icon overlay is enabled 

 Reporting 

o Tracked Resources Report:   

  This report shows any resources that have had active tracking positions 

for the date selected. 

 Zoom To 

Sets focus to a specific area of the user map that is pre-defined. Select any of the 

areas/regions under the Zoom To menu.  

 Help 

Offers limited information about the current IFM release, as well as contact 

information.  

Figure 6: Incidents that require Night Reports to be Competed 

Figure 7: Beeping Menu selections  
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2. TOOLBAR 

 
                    Figure 8: The Toolbar buttons 

 
The Toolbar appears at the top of the IFM application and provides quick access to various pieces of 

functionality. 

 Back and Forward  

Each time a user makes a change to their view on the map (zoom or pan) it is temporarily archived. To go back 

in the map history, click the Back button the Toolbar as shown in Figure 8. Click the Forward button to go 

forward again. 

 Reset Map  

To reload a map and return to the previously saved settings, click Reset Map from the Tools menu. This can also 

be done by clicking on the corresponding icon on the Toolbar shown in Figure 8. Both the icon overlays and map 

layers are reset. 

 Turn On/Off Legend  

The legend referred to is the Icon Overlays and the Map Levels on the left side of the Map Area. It can be 

hidden or revealed by clicking on the Toggle Legend Visibility from the Tools menu, or click the corresponding 

icon on the Toolbar as shown in Figure 8. 

 Turn On/Off Icon Flags  

To turn off the icon flags for some overlays on the map, click Toggle icon flags in the Tools menu or click the 

corresponding icon on the Toolbar as shown in Figure 8. The only flags that always remain are the Resource 

flags. 

 Lat Lon Selector  

The Lat Lon selector is only enabled for certain tools in IFM. An example includes selecting the coordinates of a 

destination for the Bearing & Distance tool. It also appears on various forms and allows users to quickly 

populate the Latitude and Longitude fields by clicking a location on the map while the tool is enabled. 

To use this tool, select Lat Lon Selector from the Tools menu or from the Toolbar as shown in Figure 8.  You can 

also select the button from within an editable form. Once the tool is activated, choose a map location by 

clicking in the Map Area. Your coordinate fields should be populated based on the location that was clicked on 

the map. 

 Pan   

The Pan tool is used for navigating around the Map Area. This tool moves the map around in the current zoom 

level (scale) to view other parts of the map. To use the pan tool, click Pan from the Tools menu, or the 
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corresponding icon as shown in Figure 8. When selected, click and hold a place in the map area and drag the 

map around to change position. 

Note: holding down the Shift key and dragging the map area will act as Pan without selecting the tool. 

 Zoom   

The Zoom tool is used to change the scale of the map by zooming in or out from the Map Area. To use the zoom 

tool, select Zoom from the Tools menu, or click on the corresponding icon on the Toolbar as shown in Figure 8.  

 To zoom in: use the left mouse button to click on in the map area or scroll up with the scroll wheel. You 

can also click and drag the zoom tool over an area that you wish to view in greater detail.   

 To zoom out: use the right mouse button to click on the map area or scroll down.  

To zoom to a certain region or to view the entire province in the map area, select the desired region from the 

Zoom To menu. 

Note: holding down the Ctrl key will act as though the zoom tool is selected. The scroll wheel on your mouse 

can also be used to zoom in out when the tool is not selected.  

 Measure  

The Measure tool is used for determining distance on the map. To use the measure tool, select Measure from 

the Tools menu, or click on the corresponding icon on the Toolbar as shown in Figure 8. To measure the 

distance between two points, click and hold the left mouse button starting at one object and move the mouse 

to the other location and release. You should see a box indicating coordinates, line length (miles/nm) and area 

(acres). To continue the line from the last point to another point, just move the mouse to the new point and 

click the left mouse button once. You can eventually measure an entire area by linking together the first and 

last measuring point. 

 To draw curved lines (ex: following a road), hold  the Alt button on the keyboard and click down left 

mouse button as you trace the distance with your cursor.  

 To erase all measurements on the map or to Refresh your measuring tool, click the right mouse button 

anywhere on the map. Note: you must have the Measure tool selected to get rid of the info box. 

 Select   

The Select tool is used for opening up detailed information for an icon displayed on the map. Some examples 

include opening up an Incident or Resource form. To use this tool, choose Select from the Tools menu and then 

click on an icon in the map area to bring up the detailed information. To simply preview some of the 

information, rest the cursor over the icon’s flag and a pop-up will appear. 

 This tool can also be used to multi-select icons in a certain area to view their information. To do so, click 

and drag your mouse over a portion of the Map Area. All activated icons within that space should appear in a 

pop-up list grouped by icon type. Click on one of the listed icons and their form should open. 

 Quick Picks   

This is a form that gives users a snap-shot of the status of their resources as well as quick access to log notes and 

forms for Incidents and Orgs. Users can build and maintain their Quick Picks to show anything that you want to 

have quick access to for status updates or log notes. Each user's Quick Pick can be unique. See Appendix 4 for 

more information. 
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 Location Conversion   

This tool is used to convert the between three different 

latitude and longitude formats, find the Legal 

Description or look up a location using Google. The 

initial lat and long can be generated by: 

o using the Set Lat Long button on the map 

o manually typing in coords 

o opening this tool from within the IPR or 

Incident form 

The three different coordinate formats are accessible through the dropdown.  

 

Google Address Search:   

o Search using existing coords: if you have coordinates in the LOCO form, pushing the first yellow button 

will use the coordinates to check for places or addresses nearby. A dropdown should activate and the 

user can select an item from the dropdown. When a location has been selected, the second yellow 

button will activate. Hitting this button will update the coordinates in the LOCO form.  Note: if the 

second yellow button is enabled, it means that the Google search and LOCO coords are not the same.  

o Search location or place-name: the Google Address search field can be used to look up an address or 

place-name. Type the text and hit Enter to search. The second yellow button will enable if there is a 

valid result. Hitting this button will update the coordinates in the LOCO form. 

If you opened the Location conversion tool from an Incident, the new coordinates can be pushed back in to the 

incident form.  

 Legal Description Search:   

If you have coordinates, the LOCO form can be used to look up the Legal Description. The Legal Description 

cannot be used to look up coordinates currently. 

 

 Bearing & Distance   

This tool is used for determining the bearing and 

distance from a specified Icon to a specified 

location on the map (E.g.: Incident to closest 

tanker) 

To use this tool:  

o Select Bearing & Distance from the 

Toolbar or right-click on any icon on the 

map. A window will show up similar to the 

one shown in Figure 10.  

o If an icon was used as a starting 

point, the coordinates will be 

filled in 

o Otherwise use the the Set Lat/Lon 
Figure 10: The Bearing and Distance form 

Figure 9: The Location Conversion tool 
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tool to click on the desired location on the map to fill the coordinates or type them in 

o By default, Lead Planes, Medium Rotary Wings, Tanker Bases, and Fuel Caches will be in the ‘From Icon 

Type’ section as shown in Figure 10. 

o Use the Customize button to select the desired icon type from the Icon Overlays list (turn green). You 

can have multiple icon types in the ‘From Icon Type’ list.  

o In the results part of the window, a list will appear of all of the icon types and their computed details to 

the selected destination.  

You can move through the list to see the bearing and distance of each of the icons. A red line and target will 

encircle the selected icon in the Results list. The closest selected icon type to the location will appear at the top 

of the list by default. To change the measurement type, select Great Circle, Rhumb, or Magnetic below the list. 

 This tool is often used to determine the bearing and distance of aircraft to incident coordinates (ex: 

locate closest tanker to incident).  

 Map Engines 

o AFS WMS Map  

This engine points to the BDL high resolution map layers from SDMI. 

o Selkirk Map  

This default engine includes some general map layers provided by Alaska. 

o GINA Map  

This engine points to the map engine provided by the Geographic Information Network of 

Alaska (UA). You can view SPOT5 2.5m imagery for a large part of the state. 

 

To choose a map engine, select the Tools menu > Map Engine and choose one of the map engines in the list. 

These engines can also be selected from the Toolbar by clicking the map engine dropdown as shown in Figure 8. 

The map engine button icon will reflect the map engine that is currently selected. The AFS map Legend button 

can only be used when the AFS map engine is selected. 

 Google Earth   

The Google Earth button launches an instance of Google Earth that appears in your web browser. Upon 

launching, the Google earth map should zoom to the same map view that the IFM map is currently focusing on. 

Certain icon overlays from IFM can be overlaid on the Google earth map such as resources and incidents. These 

icons are read-only and display small amount of information about each icon. All of the regular Google Earth 

features should be available for use. 

Visit: earth.google.com/userguide/v4/google_earth_user_guide.pdf for more information on Google Earth and 

compatibility requirements. 

 New Incident Form   

The New Incident button brings up a blank Incident form with some defaults filled in. For further information 

refer to the Incidents section below.  
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 IA Request Form  

The IA Request button brings up a blank IA Request form. For further information 

refer to the IA Request - Appendix 11 section below. 

 Enter Log Note  

The Log Note button brings up a blank Log Note form. For further information refer 

to the Log Entry section below. 

 Send Message  

The Send Message button brings up an empty message form. The user can choose 

which Stations to send the message to and type the message. 

 Open Prep List   

The Open Prep List button brings up a List showing all of the Prep fields from the Org 

forms.  

 AFS Legend  

The AFS Legend button will bring up a legend when the AFS map engine is selected. 

The Legend only shows what map layers are currently selected.  

3. ICON OVERLAYS AND FORMS 
 
 Icon Overlays are point data that have associated forms. There are two main types of icons in the 

system: those that can be edited and created by users and those that are maintained by administrators. 

Within the two categories there are multiple types of icons, with each type storing different information and 

displaying different visual icons.  

 The icon legend is displayed in a tree structure where expanding and retracting can be done by using 

the ‘+’ or ‘-‘.  All icons can be turned on or off by clicking on the check boxes to the left of the icon name.  The 

checkmark  indicates the icon overlay is turned on and should be visible in the map area when applicable. If 

the box is grey , some of the icons for that category are turned on (below). Finally, if the box is unchecked , 

that indicates that the overlay is turned off.  ** Hold down shift and click on the highest tree level to turn on/off 

all icons in the same tree branch.  

 Icons and icon flags are visible on the map. The icons and flags become larger as 

you zoom in to a larger scale map and smaller when you zoom out to a smaller scale map. 

Most icon overlays have a new Crosshairs button  that locates the icon on the map even 

if that icon overlay is turned off.  *Any open icon forms will have a star on the map 

indicating their location even if the overlay type is not enabled.  

Administrator Maintained Icons 

 These icons are maintained in a database inaccessible to users. Some of this information can be 

included/adjusted by support staff, often annually. Database maintained icons include: Airports and Weather 

Stations. 

 

Figure 11: Icon Overlay Tree 

Figure 12: Shift & Click on top level 
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User Maintained Icons 

 These icon locations are defined and maintained by users. The user can choose a name, location and 

enter various details for each. Each icon type has different attribute data that can be entered and tagged to that 

point icon location. 

 Creating an icon:  

o Refuse Sites, Tool Caches, Landmarks, Airstrips, Hazard Locations, Fuel Caches, Comm Sites 

o Turn on the layer of the icon that you wish to create  

o Select File > New > Select desired icon type 
o Create a unique label  
o Type in a Lat and Long or use the Set Lat/Long button (click the button and then click a position 

on the map to auto-fill the coords). 

o Fill in any other fields > Save 

 Editing an icon/form 

o Turn on the layer of the icon that you wish to edit  

o Click on the existing UDO that you wish to edit  OR  open the List from the List menu and click 

on one row 

o Edit any information > Click ‘Save'  

 Deleting an icon/form  

o Open the form/icon that you wish to delete (click on icon OR List item) 

o Select ‘ Delete’  

o A pop-up will verify that you wish to delete the icon 

 

INCIDENT ICONS/FORMS 

The Incident form captures incident information and can be saved to the map as an icon. It allows the 
information to be shared among many users in real time. It is therefore very important to keep the incident 
form as up-to-date as possible when new information is revealed.  
 

Icon Colour - Incident Type  Details 

Fire   All wildland fires which DOF resources attack, suppress, or 
routinely monitor as a fire management action. 

RX - Prescribed   Deliberately ignited fire for the purpose for forest 
management, to remove heavy fuel buildup or simulate natural 
cycles of fire in the ecosystem. 

RFA - Request for Assistance 

 

Any incident not a fire managed by one of the 3 suppression 
agencies. Include: VFD fires, lower 48 responses, ESF-4, 
DMVA/DHSEM, Northwest Compact. 

PRJ - Project Fire  Any non-incident that requires the assignment of resources. 
Examples: hazard fuels projects, timber cruising projects, 
education events. 

Nat Out   All wildland fires which were discovered but have been 
extinguished by natural causes prior to initiation of suppression 
action. No suppression or monitoring has occurred. 
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F/A - False Alarm   All reported fires on which some type of response was initiated 
but no wildland fire was found and no suppression action took 
place but response costs were incurred. 

SR - Smoke Report   All reported fires on which some type of response was initiated 
but no wildland fire was found and no suppression action took 
place and no costs were incurred. 

 
  
 

 

 

 

 

 

 

 

 

A new Alaska Incident can be created in three ways:  

1. Recommended: Click on the 'New Incident' button in the Log Entry .  User should try to type the 

initial report of the incident in their Station log, then create a new 

incident and copy/paste the station log.  

2. Select File > New > AK Incident.  

3. Click on the corresponding icon on the Toolbar  

o Choose which Station that you are creating the incident for. It will 

default to your User Preference setting. 

When the new incident form opens, there are certain defaults that are automatically set on the form (e.g.: Type 

= Smoke Report). The incident number and Management Office are defaults and originates from the User's 

selected home base (File > User Prefs). The defaults are handy when the user wishes to start typing log notes 

for the incident immediately. The default fields can be updated and overridden as the information becomes 

available. 

 Although, these fields are already populated on creating a new Alaska Incident, the following fields 

always need to be filled in order to save any incident:  

 Number, Type, Status, Latitude and Longitude 

 

For a step-by-step guide on incident creation, see Appendix 1. 

 

The incident form is split up into eleven panels so that the information can be accessed as necessary (Figure 

16). All eleven of these panels can be minimized or maximized at any time by clicking on the double arrow icon 

Flag Colour - Incident Status Details 

Uncontained Fire spread is unchecked. 

Controlled Fire line or natural boundaries completely enclose the fire, 
there is still potential for escape. 

Contained Fire line or natural boundaries completely enclose the fire and 
should withstand any weather conditions.  Potential for escape 
is minimal. 

Out No flames or smoke visible, no heat remaining. 

Finalized All components of the report have been completed and 
reviewed. 

Approved The reviewer (SLC) has signed off on the final report. 

Completed The AICC has signed off on the final report. 

Table 1 & 2: Incident Icon Colours and Flag 
Colours 

Figure 13: Create new Incident pop-up 
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 on the right side of the form in each panel header. When minimized, the headers will display a snapshot of 

the information from within the panel.  

 

The top Toolbar on the incident form contains 13 icons: 

1. Save   - Saves all changes 

2. Revert Changes  - All unsaved changes made to the incident form will revert to previous values 

3. Center Map   - Centers the map to the selected incident 

4. Show Crosshairs   - Displays crosshairs on the map over the icon location. 

5. Location Conversion  - Allows users to convert between three coordinate formats and push the 

coordinates to the form 

6. Add to Quick Picks    - Adds the Incidents to the user's Quick Picks list 

7. Open Report    - Launches a PDF report which can be Printed or Saved. Note that the print function 

is not enabled until the form is initially saved. For more information on Incident Reports refer to the 

Reports section. 

8. Open Log Entry Form   - Launches the Radio Log for this particular incident  

9. Create an IA Request   - Launches an IA Request for this particular incident 

10. Copy to TTY  - Copies pre-determined fields to the clipboard and enables you to paste it anywhere. 

The main intention is to paste to the TTY to request a fire # 

11. Copy to Email  - Copies pre-determined fields and launches an email that is auto-filled with incident 

information.   

a. Email Incident Details: this launches an email with incident data that can be addressed to 

anyone. 

b. Email Inc Details to Land Managers: this launches an email that is addressed to the Land 

Manager tagged to the Admin Unit in the Incident form. The email addresses can be adjusted 

before sending the email. 

12. Incident History  - Launches a form that will display the historical changes for all of the incident 

fields. The user can select which fields they would like to view the history for. (See Incident History) 

13. Delete Incident and Close Form   - Deletes incident from the Map and List. This should only be used 

when an incident is created by mistake. Contact Support if you have unintentionally deleted an incident. 

 

 General Panel  

The General Panel is designed for users to input basic and vital information to build a general knowledge of the 

incident. The 'Type' field determines the color of the icon on the map and the 'Status' field determines the color 

of the icon flag on the map (see Table 1 above). As information is updated within this panel, the General Panel 
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header will update and summarize information entered. The Management Office field will auto-fill based on the 

user's set User Preferences (File Menu). 

 Location Info Panel      

The Location Info Panel contains information regarding the geographic location of the incident.  

The Latitude and Longitude can be manually entered or the Lat Long Selector button   can be used to 

populate rough coordinates by clicking in the map while the button is selected (see Lat Long Selector under 

Toolbar). The Location conversion tool can be used to convert from various formats to the incident form.  

When coordinates have been confirmed on site, the user can lock the coordinates so that others know that they 

are correct. The coordinates can be unlocked if necessary by clicking on the lock icon again.   

 Frequencies Panel      

The Frequencies panel displays the various Frequencies that are important for the incident. Users can add or 

delete frequencies using the  and  buttons.  

o Frequency Type: this is a dropdown: Air to Ground, Command, Tactical, AirGuard, Other 

o Name: a dropdown with various frequencies or users can type their own 

o Comment: a text field for entering any important information 

 Site Info Panel    

The Site Info panel contains information about the weather and indices at the start of the fire as well as some 

landscape and topographical information. The  button can be used to fetch data from the map to fill in some 

or all of the Site Data at Start of fire fields. The  button can be used to fetch the nearest weather station to 

the fire. Clicking on  when there is a weather station filled in will open the weather station form for 

that specific station. 

 Values at Risk Panel    

The Values at Risk Panel is designed for users to input up-to-date information with regards to properties 

threatened and/or lost by the incident.  The values Threatened are intended to be Daily values while the values 

lost are Cumulative. 

 Incident Status Summary Panel    

The Incident Status Summary Panel displays four Incident Statuses, the time/date when the status was set and 

the size at that time. This panel is fed directly by status changes from the General panel, but it is only fed when 

the applicable row is empty. (E.g.: a row that is filled in will not be clobbered by automated updates). The user 

can edit and override the timestamp or size at any point. 

 Land Status Panel   

The Land Status Panel is available to users for entering information with regards to owners of the land and the 

protection level. More than one land status entry can be captured, however; a primary type must always be 

selected. 'Primary' indicates where the incident started. Total Size will be tallied in the bottom right corner but 

does not link directly to the Current Size field in the General panel. The user must ensure that the Current Size 

field matches the Total Size in this panel before the Incident can be Finalized (validation prompt if not). The 
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Primary land status will fill out automatically when an incident has a valid location within Alaska and is saved to 

that location. Users can also use the  button to select the most up-to-date Primary land status information. 

 The incident toolbar has an option to 'Email incident details to Land Managers'. The Land managers are 

those associated with the Admin Units in this panel. These email addresses are connected to Admin Units 

through the Provisioning tool (Appendix 8). 

 Incident Details Panel    

The Incident Details Panel holds additional information with regards to the Legal Description, Reporter of the 

incident, Confirmed Legals, and the Primary Protection Agency for the incident. The user can edit these details 

at any time. The   button will attempt to fetch the Legal Description from map data. Users are able to 

request a fire code here by selecting the ‘Fire Code Requested’ button. 

For more information on Final Fire Report Approval or Finalizing an Incident, see the Finalizing section below. 

 Night Report Panel   

The Night Report Panel is designed to capture important daily information about the incident. 

The header of this panel will inform the user if a Night Report is Required.  

 Night Reports are required for:  

o any Wildfire, or Prescribed Fire with a status of anything other than Out or Finalized (unless 

called Out within last 24 hours).  

o any Natout that has been called out within the last 24 hours 

o any Request for Assistance that has a 6 digit incident number, and a status of anything other 

than Out or Finalized (unless called Out within last 24 hours) 

 There are many fields that are mandatory in order to Complete a Night Report, which is done by hitting 

the Complete button. The mandatory fields are verified at that time, and the user is warned if any 

mandatory fields are empty.  

 When the user hits Complete, any assigned Crews will appear in the Night Report panel (try to indicate 

only those assigned overnight). Note: a Night Report can be Completed multiple times in a day, with the 

final Complete overriding any previous for that day.  

 Successful completion of the Night Report will display 'No' Night report Required in the header and the 

Incident List highlighting will change from brown to white. 

 Night Report fields will clear out automatically at 04:00 (Cost values, Narrative, etc) so that new values 

can be entered the next day. 

 Negative cost values can be entered to correct previous Night Report submissions 

For more information on Submitting a Night Report refer to Appendix 1 for a Night Report Submission how-to. 

 Resources Panel   

The Resources Panel displays current resources assigned to the incident. Resources can quickly be assigned to 

this incident via the Assignment drop-down, which is ideal for assigning many resources one after the other. 

Resources can also be quickly unassigned with the 'Un-assign Selected' button.  

 New functionality in this panel includes the ability to Status and move resources on the map through 

Right-clicks.  Simply right-click on the resource or multi-select a few, select the applicable right-click option 

(status, move, alert, unassign).   
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 It is important to save changes. Resources will be highlighted in either green, red or grey if there are 

unsaved changes (green to assign, grey to un-assign, red for status change).  

 Attachments  Panel 

The Attachments panel allows users to attach various files to the incident form. The file types are not restricted 

(e.g.: jpeg, pdf, doc, docx, xls, xlsx, ) nor are the number of attachments or size of attachments.  

o  - Add a new file to the Incident form. 

o  - Remove a highlighted file from the Incident form. 

o  (or double click)- Save a file to your computer from the Incident attachments, and open the file. 

Files that are attached to the Incident live in an external Content Management system on a separate server. The 

Incident files can then be accessed by any users with permissions in IFM and they do not have to be saved 

locally computers. If files of the same name are added, the version number will increase and the newer version 

will be available on the Incident. (Older file versions can be viewed by going directly to the Content 

Management system website). 

Note: if the attachments server is unavailable, there will be a warning to users.  Previously uploaded 

attachments will be unavailable until the server is reconnected. 

 
 Finalizing an Incident 

After an incident is called Out, the incident information must be reviewed within a certain number of days. The 

status of Finalized, indicates that the incident has been reviewed and the information is correct.  

After reviewing the incident information for an Out incident, the user can enter their name in the 'Final Fire 

Report Approval' field of the Incident details panel. Only after a name has been entered in that field and the 

Current Size = Total Size (Land Status panel), can the status of 'Finalized' be selected and saved for an Incident.  

Note: Finalized incidents cannot be selected in the Log Entry or Quick Picks. To do so, go directly to the incident 

form and use the 'Add to QP' button or 'Open Log Entry' button. 

 Log Entry 'Small Incident form' 

The bottom panel of the Log entry form contains a subset of some of the incident fields from the large incident 

form. The fields in the log entry incident form can be edited and have their own SAVE button within that panel. 

The fields should match in the panel and main incident form as long as changes have been saved correctly.  

The idea is that users can quickly create new incidents in the log entry and type log notes for the incident 

immediately.  

 

 

 

Figure 14: Incident Attachments panel 
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 Incident History Viewer (Changes to Incident fields)   

The Incident History viewer is a pop-up that opens directly from each incident form. The viewer is similar to a 

List, and allows users to view changes that have been made to specific fields on the incident form. The fields are 

represented by columns in the viewer (e.g.: change in size over time). The user can choose their fields of 

interest by using the column selector in the top right corner .  The user can also choose to save their column 

selections and settings so they will be a part of the dropdown.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 15: Incident History Viewer  

Figure 16: Incident Form  
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ORGANIZATION ICONS/FORMS  

Organizations are defined bases generally where resources are found when not assigned to incidents (e.g.: Area 

Offices, Tanker Bases).  

Resources have a 'Home Unit' field and a 'Current Assignment' field, which are populated with Orgs. The Home 

Unit should represent the resource's home base, and should stick with that resource through the season. The 

'Current Assignment' field is used if a resource is temporarily working out of another base. 

 

There are two panels in the organization overlay: the Organization Information panel and the Resource panel. 

An additional two panels appear only in Area Offices and is the Additional Information (Cost) panel and the 

Preparedness Panel. 

1. Organization Panel:  The first panel contains information about the organization. It displays the 
organization name, organization code, organization type, parent organization (if there is one), location, 
Contact Info, and Details. The toolbar buttons include (in order): Save, Revert Changes, Centre Map, 
Show Crosshairs, Open Log Entry (Area Offices only), Add to Quick Picks (Area Offices only), Reports, and 
View Change History (Area Offices only). 

 

 

 

 

 

 

 

 

 

 

2. Preparedness Panel:  This panel contains information regarding to Preparedness levels and staffing for 

that day in that area. The top of the form (Prep Level to Acres/ 60 min) information is provided by 

Mobile IFM > prep per area. To quickly access this page and edit details or simply view more 

information, the user can hit the  button. This will launch the Mobile IFM site. Users will 

need to log in with their User ID and then will be brought to that area’s page. All other editable fields in 

this panel can be edited and updated on both this panel and in Mobile IFM. 

3.  Resources Panel:  The 'Resource' panel displays the resource table and allows for the ability to add, 

status, or move resources to this organization/base. The resources have right-click options when 

highlighted (status, move, alert). 

4. Additional Info Panel:  The Additional info panel is only available for Area Offices or main Orgs. The 

panel contains cost fields that are mandatory to fill out every evening as an Area Office Night Report. 

Figure 17: Main panel of Org form 

Figure 16: Incident form  
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The panel header and Org List will indicate whether a Night Report is required or not. Hitting the 

Completed button will verify that mandatory fields are filled in. Note: an Org Night Report can be 

Completed multiple times in a day, with the final Complete overriding any previous entries for that day. 

See Appendix 2 for more information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESOURCE ICONS/FORMS 

Resources are important icons in IFM. These icons can be updated through Automated Flight Following devices 

feeding point locations to satellites/ cell towers or they can be user-edited. The locations for the tracked 

resources are updated in the Map Area every two minutes (aircraft) or every five minutes (engines). As the 

resource position is updated on the Map Area, the points on the map are stored so that historical tracking can 

be viewed for any date in the past. Flag and text color combinations are based on availability and tracking of the 

resources as described below. 

 Resource Flag Colours 

o  Yellow flag/ black text: signifies Assigned and had a recent position update (tracking) 

o  Black flag/ yellow text: signifies an Assigned and non-tracking resource 

o  Green flag/ black text: signifies Available and had a recent position update (tracking) 

o   Black flag/ green text: signifies an Available and non-tracking resource 

o  Blue flag/ black text: signifies Out of Service and had a recent position update (tracking) 

Figure 18: Cost panel on Area Office form 
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o  Black flag/ blue text: signifies an Out of Service and non-tracking resource. 

o   Red flag/ black text: signifies a resource previously yellow that has lost tracking for a 
period longer than 10 minutes. 

o   Purple flag/ black text: signifies a resource is overdue for a check-in. See Log Entry for 
details. 

 

 Resource Availability 

Refer to the Appendix 3 for information about resource statuses and availability. 

 

There are 8 Main Panels on the Resource Form: General Info, Location, Status, Associations, Details, Tracking 

Equipment, History and Utilization. All of these panels can be expanded or minimized and the headers display a 

snapshot of what is contained within the panel. Only four of the panels are editable in IFM: Location, Status, 

Associations, and History. The Toolbar buttons are as follows: Save, Centre map, Show Crosshairs, Open Log, 

Unload History, Add to Quick Picks and Reports. 

 

 General Panel   

This panel has basic information about the resource. This information can be edited through the Provisioning 

tool, which opens in your web browser. 

 Location Panel   

From this panel, users can edit the resources latitude and longitude by typing or with the lat/lon selector tool. 

To use the lat/lon selector, press the button  and click on the map to the desired location. To put the 

resource icon at a base or other icon for example, click on the base icon flag with the Set lat long tool. 

 Status Panel   

This panel contains information regarding the contract, ICS status, Alert Status, Schedule and regular status of 

the resource. The Hourly Cost field can be edited through Provisioning. There are 3 ICS statuses for resources: 

1. Assigned: when resource is Assigned to an Incident 

Figure 19: Resource form Layout 
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2. Available: when resource is Unassigned and any status except Off Duty 

3. Out of Service: when resource is Unassigned and Off Duty status 

For more information about Resource Statuses, ICS and Contracts, refer to Appendix 3 . 

 Association Panel   

From this panel the user can assign the resource to a Home Unit, a different base (Current Assignment) or an 

Incident. The user can also move the resource icon on the map by selecting the  button beside the desired 

location.  

 Details Panel   

This panel contains a basic description field and an image, if there is one attached to the Resource through the 

Provisioning pages.  

 Tracking Equipment Panel   

This panel displays the ESN and Provider information managed through the Provisioning pages. 

 Resource Position History   

Within this panel the user can select a date range or choose a pre-selected position trail to view the resources 

positions in a given time range. The history trail for the resource will appear on the IFM map. All historical 

records for a given time range will be displayed at the bottom of the History panel. For a continuous track, 

ensure that you have the Current Position trail enabled instead of a date range. You can hover over any of the 

yellow position dots to get detailed information about that position (speed, alt, etc). 

 To turn history off on a map, select the Remove History button.   If you are unable to locate which 

resource has the history trail, select one of the trail dots to open the applicable resource form. See Appendix 3 

for more information. 

 Utilization Panel 

This panel displays Resource utilization information for the past 5 days. Utilization data is generated from 

resource tracking or from a user updating resource statuses. The Utilization data should match the Active 

Duration Report for that resource. For more info refer to Resource Durations below.  

 Dead Reckoning Functionality  

The dead reckoning tool is used for calculating the estimated current position of a tracked resource. This is used 

because aircraft locations are only updated every two to five minutes in the Map Area and therefore their icon 

positions can be outdated. When the tool is enabled, a calculated current position of a resource is displayed as 

a small red dot. The dot is attached by a line to the last known position of the resource. The position is 

calculated from the last known location, the speed and direction of the resource. Note: this tool only enables 

when the aircraft is travelling above 100 knots. 

o From the Menu Bar select: Tools > Dead Reckoning 

 Resource Icon Filters 

Resource icons can be enabled or disabled like any other icon overlay in the icon tree. The Resource icon 

overlay tree consists of Resource types (eg: Aircraft > Fixed Wing > Birddog). Users can further filter what 

resource icons appear on the map using the Resource Filter button in the toolbar.    
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 The filter pop-up (Figure 20) allows users to choose which resource attributes (fields) that they would 

like to filter on.  For example, a user could choose to display 

resources that are Actively moving and have an ICS status of 

Available. Note: the filters are remembered until they are 

manually edited.  

o  - Choose filters     

o  - Remove the current filters 

o  - Apply the current filters 

 Lost Tracking 

If a resource has a position update, and then does not receive another update for 10 minutes, two things will 
occur: 

o The resource flag will flash red on the map  

o The resource will appear highlighted in Red in the resource list/ status bar icon will add a number 

This warning state happens so that the user's attention will be drawn to that resource in case the situation is 

serious. Some non-serious causes could be that the resource tracking device was turned off, the resource 

landed at a non-defined base or the satellite connection was lost for an extended period of time. 

 Create New Resource 

New resources are created through a Provisioning tool which opens in a web browser. Only certain users have 

permissions to add new resources. For more information refer to Appendix 8. 

 Resource List 

The Resources list has more functionality than other Lists.  

o Multi-select - hold Shift key to select a group of resources or Ctrl key to select various 

resources in the list 

o Right-clicks - if you highlight a Resource or multi-select a few and right-click, there are 

several more options than other forms (Open Form, Open Log Note Form, Add to Quick 

Picks, Resource Status, Alert Status, Edit Schedule, Contract Status, Move To, Unassign). 

Any right click option selected will take immediate effect. 

o Drag & Drop - the ability to drag and drop from the List to Incident Form (Resource panel),  

Quick Picks, Org Form (Resource panel) 

o Alarming Resources in Lists:  

There are two reasons why a resource could be highlighted in the List.  

1.) When a resource is overdue for a check-in it will be purple. The resource status must 

be changed or a log must be entered to resolve. In the log entry, you can also empty 

the check-in field and save. (At Base or Off Duty will clear the check-ins).  

2.) When a resource has had no new position updates for more than 10 minutes when 

tracking, it will turn red. After five minutes, the resource will no longer be red. 

 

See Appendix 6 for information on accessing the Alarming resource list via the Status bar.  

 

Figure 20: Resource icon filters 
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 Resource Duration Reports 

Durations: when a resource is actively generating time against an incident or area office/station. An estimated 

cost can be generated from the duration time (Active Duration Report & Summary).  

 Aircraft Durations: 

Aircraft Durations are triggered by two things:  

1. Resource tracking devices: When a tracking device fires up, the duration starts. When the 

tracking device has not had a position for more than 10 minutes, the duration stops at the 

time the last position was received. 

2. Resource Statuses: Certain statuses that start and stop resource durations. These statuses 

are set by users. 

The duration start and stop is triggered by whichever of the two things happens first, the tracking 

device or the resource status change.   

 Other Resource Durations: 

Other resource durations (e.g.: engines) are triggered by only one thing: 

1. Resource Statuses: Certain statuses that start and stop resource durations. These statuses 

are set by users. See Table 1 in Appendix 3. 

For more information on Resource Durations refer to Appendix 3. 

 

LOG ENTRY FORM 

The log entry form allows users to capture log notes for Resources, Incidents or Bases/Organizations. The log 

entry form also allows users to assign resources to incidents or current assignments (forward base), set check-in 

times for resources, set resource status and build resource durations among other things. Note: users are 

encouraged to use the Tab key to move around the main log entry panel for speed and efficiency. 

Opening Log Entry form: 

 F3 key: This hot key will open the log entry form if cursor focus is in the IFM application. The F3 key will 

also clear out the <Selection> field so that another selection can 

be made immediately. F3 will prompt if there is unsaved 

information.  

 Toolbar Icon or Tool menu:  Selecting this icon on the main 

toolbar will open the log entry form.  

 Quick Picks: Double click on any item in the Quick pick list to 

open the Log entry. Highlighting and hitting the L key will do the 

same. 

 Lists: Resource, Incident, Org: highlight an item and hit L key or 

Right-Click > Open Log Entry Form 
Figure 22: Log Entry 

Selection 

Figure 21: Alarming Resources in List 
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 Opening from another form: The log entry form can be opened directly from any Resource, Incident or 

Base/Org form. At the top of each form you will see a button to open the log entry.  

Working with Resources: 
There are various actions that can be done when a resource is selected in the Log Entry. These actions can be 
performed separately or at the same time to increase efficiency. Use the Tab key to move around the log entry 
fields and use keyboard shortcuts when possible (e.g.: E = Enroute) 
 

1. Selection: the selected Resource, Incident or Org that the changes/ log notes are for 

2. Log Note: User can type log notes that appear in chronological order in the Log History 

3. Assign/ Unassign: User can assign a resource to an incident or Org. They can also Unassign from 

incidents or Current Assignments. 

4. Status: User can Status their resources via the dropdown (e.g.: Patrol - To be explained below). 

5. Set Check-in Time: User can set a check-in time for any resource. 

6. Default Check-in Time: updating the resource will update the check-in time based on the default (e.g.: 

typing a log note, changing a status, etc) 

 

 

 

 Log Note 
The log note section is where notes can be typed about a resource or any important information. Notes can be 
quickly typed and saved by hitting ‘Enter’ on your keyboard. Notes can also be saved by clicking on the 'Save' 
Icon on the right-hand side of the panel. Saving these notes can be in occurrence with other changes such as 
assignments and adding a check-in time. 

 Log Entry Assignments 

The Assignment field indicates where a resource is currently assigned, whether it is an Incident, Home Unit, or 
Current Assignment. Resources have Home Units that indicate where they generally are based (for more info 
see Resource section above). If a resource is away from their Home Unit, they will have a Current Assignment 
set (e.g.: a different Area Office or a forward base). If the resource is assigned to an incident, that incident will 
always appear in the Assignment field.  
* Log notes and actions against a resource will also appear in the log history for an incident if the resource is 
assigned to one. If not currently assigned to an incident, the resource log notes and actions will appear in the 
log history for the Current Assignment or Home Unit (if no Incident or Current Assignment).  
*The Quick Picks are also available for quick resource assignments. Refer to Appendix 4 for info. 
 
Assign - Users can assign resources to incidents from the log entry by entering the incident number (or partial 
number) in the Assignment field. Users can also assign resources to Current Assignments if they are not 
assigned to Incidents.  

Figure 23: Log Entry Form Basics 
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Unassign – Users can unassign resources from incidents by deleting the incident from the Assignment field. 
Users can also unassign resources from Current Assignments (e.g.: forward bases) by selecting the resources 
Home Unit from the Assignment dropdown list. 

 Events/Statuses 

Events in IFM refer to specific points in time that indicate a change in Status generally.  There are different 

types of events for Resources and Incidents.  

o Resource Statuses 
Resource statuses refer to the resource's current activity (e.g. Enroute). These statuses drive duration reports 
for some resource types (see Appendix 3). The resource statuses in the log entry include: 

 At Base - back at base. Clears check-in. 

 On Scene - on scene at incident (still actively flying for aircraft) 

 Enroute - left base for incident, left incident for base or elsewhere 

 Patrol - left base for something other than an incident 

 Off Duty (When Assigned) - stopped work for the night/ over-nighting on a fire. Clears check-in 

 Off Duty (When Unassigned) -Unavailable  

   

 Non status selections: 
o Manifest - highlights the log pink in the log history to show the resource manifest 
o Flag - highlights the log purple in the log history as an important note. These flagged 

logs appear in the log history no matter what date range is selected. Best to remove the 
'Flag' event if the log is no longer important. 

o BLAST All – sends the log to mobile IFM BLAST page for all landowners. 
o BLAST Statewide – send the log to mobile IFM BLAST for Statewide only. 
o BLAST Dispatcher – sends the log to mobile IFM BLAST for Dispatchers only. 

 Check-In Times 

IFM users can set check-in times as reminders for when a resource is designated to check in. The time displayed 

in the check-in field indicates the scheduled check-in time. The user can type in any time for the current day, or 

they can use the calendar button to select a future time/date for the check-in.      

 Users can type the desired check-in time in hh:mm (e.g.: "1200")  

 Users can use the current time to set the check-in. E.g.: typing "+15m" will set the check-in 15 mins 

from now. Typing "+3h" will set it 3 hours from now. Typing "+1d" will set it one day from now.  

 Note that any time entered that is more than an hour in the past will default to tomorrow. (E.g.: if it is 

currently 15:00 and the user types 13:00, the new check-in time will be 13:00 tomorrow. 

 Any time entered within the last hour will result in an alarming resource (audible alarm and flashing 

purple flag). E.g.: if it is currently 15:00 and the user types 14:20, the resource will alarm as 40 minutes 

overdue. 

 Default check-in times:   

o Resources can have default check-in times set for their particular resource or they can be left 

empty. These default times can be defined by resource type (e.g.: every two hours for an 

engine) or more specifically by each resource (e.g.: M-22 every 15 mins). The default time is 

displayed beside the check-in calendar button (e.g.: 30m).  

o If a resource has a default check-in time (e.g.: 30m), the check-in is automatically reset when 

certain actions are done. Making certain changes in the log entry will reset the check-in time 

(log note, change status, Assign/ Unassign). 
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o Actions outside of the log entry can update resource check-in times as well. (Change status or 

Assign/ Unassign though Quick Picks or forms). 

 Stop check-in:  

o Empty the check-in field in the log entry    OR  

o Select Off Duty or At Base resource status 

There are two ways to save changes made in the Log Entry panel: 

1. Save & Check-in:  This is the default button (Enter key = Save & Check-in). Using this button or the 

Enter key will cause any changes made in the log entry panel to result in a check-in. For example, if it is 

currently 15:00 and your resource has a 2h default check-in, typing a log and using Save & Check-in will 

result in the check-in field displaying the new default check-in time of 17:00. 

2. Save Changes:  Using this selection allows users to make changes in the log entry panel without 

overriding a defined check-in time. For example, if it is 15:00 and a check-in is set for 16:15, the user 

can type a log note, assign a resource or add an event without changing the check-in time. This option 

can be accessed via the Save dropdown on the log entry. 

 Overdue Resources 

If a resource misses a check-in time, six things will happen to warn the IFM user that a resource is overdue: 

1. The resource flag will blink on the map   

2. The resource will appear highlighted in purple in the resource list 

3. There will be an audible alarm, if the user enables beeping       

4. The check-in time in the log entry will be highlighted in pink   

5. The resource callsign will appear purple in the Quick Picks   

6. The number of alarming resources will increase at the bottom of the dispatch screen and the resource 

will be added to the ‘Alarming Resources’ list.  

 

 Log History 

The Log History section found in the Log form contains historical log information for resources, incidents, and 

organizations. The information that is saved and displayed here includes: 

 Time Occurred - editable 

 Time Entered (when the save happened) 

 User (who generated the log or event) 

 User@ Org (who generated the log or event & what their User Preferences are set to) 

 Deployment (to incident, organization, etc.) - editable 

 Event (e.g. 'Assigned') - editable 

 Resource  

 System Generated? (non user-typed log) 

 Log /Message 
 
Log Note Types: 
There are currently two different types of log notes: manual or system-generated. These will appear 

under the 'Log/Message' column in the Log History. 
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1. Manual: Log notes are manually typed by a user. In the Log History, the background highlighting is 

non-existent and the logs are basic black on white (unless the Manifest or Flag event is chosen). 

2. System-Generated:  Log notes are generated by different actions saved either in the Log note form 

or on the related resource, Incident or Base form. For example, if you change the event for a 

resource from At Base to Enroute, the log history will generate a log that says 'At Base --> En Route.' 

 
Log History Filters: 
When a resource, incident, or organization/base is selected in the Log Entry, a default range of log 

history will appear in the log history section.  Logs will display that were entered ‘Today’.  

  - Drop-down selection of days user would like to view for that selections 
history. Options include: Today, 3 days, 7 days, 30 days, and a date range selector. 

  - Text search most of the columns 

 - Show only events that could trigger Duration start and stop 

 - Show only User Typed log notes 

 - Show only System generated log notes 

 - Show only Messages that have not been 'Marked as read' 

 - Launches the Log Viewer list 

  - Exports the log history to excel. The user can choose which columns to export. 
 

Editing the Log History: 
In the Log History section, only the Time Occurred, Event and Deployment columns are editable.  

 To edit, click in the column that you would like to change. Once you have made your change, 
the entire line text will turn red to indicate a change has been made. Save the changes by 

clicking on the save icon  or cancel the changes by clicking on the revert changes button 

 in the Log History Toolbar. 

 NOTE: when editing times you may have to adjust multiple rows of history (e.g.: system-
generated log and user-typed log that occurred at the same time! 

 
 
 

 
 
 

Figure 24: Editing Log History 
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Displaying Columns in the Log History: 

In the Log History panel, to the right of the 'Log/Message' header is a small arrow . Select or de-select 
any of the columns. Differences between the two Time columns would indicate if that row has been 
edited. 
 
Different Colors of Log Notes in Log History: 

 In the log history section you will notice different colored rows.  These different colors represent a 
 specific type of log.  
 

Row Color Log Type / Meaning Example 

White User Log Note "Fire is moving East quickly" 

Yellow Resource Activity Change En Route --> At Base; Assigned; Unassigned 

Peach Location Change Tracking start or stop 

Pink Manifest Event Today's manifest = Smith, Jones, Anderson 

Purple Flagged Log Important Log that a user would like to highlight 
(Flag event) "Scheduled Power outage @ 10:00" 

Green Message A Message to an Org/Station that they have to 
Acknowledge:  "Heli is enroute to your base" 

White w/ 
gray writing 

Disregard Log has been disregarded. 

 
 Log Messaging 

The Station logs can be used to send messages between stations (offices/ bases).  
Messages are defined as notes that are inputted into Station logs, but include notifications so that they are 
noticeable to the receiving centre. Each user is associated with a Station through their User Preference 
selection (File menu).  
 Users can send Messages to multiple stations at a time if they wish. They can multi-select using the 
‘Add’ button menu or by typing in the drop-down on the form to add locations to message. All Messages appear 
highlighted in green in the Log History for the receiving station. The count of 'Unread' messages also appears in 
the status panel for the receiving station. A recipient at the station can 'Mark the message as Read' and it will 
turn the Message in to a regular log note. Senders can also choose to 'Log to (cc)' which places the log note in 
the station's log history, but does not turn the highlighting green or the status bar. 
For more detailed information on Messaging, refer to Appendix 6. 
 

 

Table 3: Log History Line Colors 

Figure 25: Message form 
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4. MAP LEVELS  
 Map Levels are overlays that can be enabled in your map area, but are not 

point data like the Icons. These layers allow the user to create a map by turning layers 

on or off.  Controlling the Map Levels is very similar to the Icon Overlays where the 

checkmarks indicate whether or not the layer is turned on. The only difference is that 

after a change is made in the Map Levels, the Apply button must be clicked for those 

changes to take effect.  

 Some layers require the user to’ zoom in’ before they are visible.   

 The layers have an ordering that is pre-defined. Certain layers appear above 

others (e.g. trails over park land). 

 

 

 

5. MAP AREA 

 The map area includes the largest portion of IFM.  It is the actual map space displaying a base map 

which can be manipulated with icon overlays and map levels as required.  The Icon Overlays always appear 

above any activated Map Level. 

 On start up of the application, a default map will be displayed. This map can be defined by the user in 

regards to: location, scale (zoom factor), icon overlays enabled and map layers enabled.  The user can also save 

various other maps to be launched in separate windows at any point. 

 New Map Area 

 This launches a new window with a default map. 

 File > New Map       

 Saving a Map Area 

o Zoom and pan to the desired map area 

o Activate all desired Icon Overlays 

o Activate all desired Map Levels. Click ‘Apply’ 

o File > Save Map As > Type a name for your map. Click 

‘Ok’  

 Click ‘Load on Startup’ for the map that you 

wish to launch automatically every time the application launches. 

 You can save any map with 'Load on Startup' unchecked to ensure that it does not load 

each time the application starts 

 Re-saving an existing map will override all settings with what is currently selected (zoom 

level, icons, map layers, etc) 

o  It is a good idea to delete the old 'Default map' (or you will have two launching on start-up). 

You could re-save the Default with Load on Startup unchecked also. 

Figure 26: Map Levels 
enabled/ disabled 

Figure 27: Saving a new map 
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 Launching a Saved Map 

o File > Launch Map 

o Choose the desired map from the list of saved maps 

o A new instance of the application should open with your 

saved map 

o Note: Maps with a ~ in front of them are your user maps. 

Maps with no ~ are ones created by GlobalAdmins 

 Deleting a Saved Map 

o File > Delete Map.  

o Choose the desired map to delete. Click ‘Yes’ 

o Note: Maps without a ~ in front of them are created by the GloabalAdmin and cannot be 

deleted by a user. They can only be edited/ deleted by the GlobalAdmin. 

 Printing a Map Area 

o Zoom and pan to the desired map area (or launch the appropriate map) 

o Activate all desired Icon Overlays 

o File > Print Map 

 
 

6. STATUS BAR 

 The status bar displays the scale of the current map view, the progress indicator when the map is being 
downloaded, the coordinates of the position of the mouse in the Map Area and the lightning count (when tool is 
in use). 

 Scale Bar: 

 The scale of the map is displayed in the format “1: 8,000,000”. The scale represents the ratio of a 
 distance on the map to the actual distance on the ground. Eg: At a scale of 1: 8,000,000,  1 inch 
 on the map = 80 miles 

Figure 28: Launching a Saved Map 
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Progress Indicator: 

 The Progress indicator appears directly under the Map Levels in the Status Bar.  It is a small bar that 

 illustrates when data is being added or removed from the current Map Area.   

 

 Coordinates: 

 The coordinates are displayed down in the bottom right corner of the status bar. They are displayed as 

 the user moves over the Map Area while using one of these tools: Select, Pan, Zoom, Measure, Point ID, 

 Lat Lon Selector.  The Latitude and Longitude can be displayed in four different format types: 

degrees/ degrees-mins/ degrees-min-sec / UTM.            

Click in on the coordinates in the bottom right corner to change the coordinate format.                                                 

         

 

 Notifications: 

This section advises the users if there are items that they should be paying attention to.  
o Resources: The purple section indicates if there are any resources that are overdue for check-ins or 

have lost tracking (e.g.: 3 Resources). Clicking on the icon will launch the Resource List filtered to 
show those resources. 

o Station Logs: This section indicates how many Station logs have been entered for this particular 
user's Station (User Pref). The number will show how many logs since the user either launched IFM 
or since they have last had their Station log open in the current session. Clicking on this icon will 

launch the Log History for the Station and filtered to show only User-typed logs.  
o Station Messages: This section indicates how many Messages are active for this particular user's 

Station (User Pref). Clicking on this icon will launch the Log History for the Station and filtered to 

show only the Messages.   
 

 Connection Stats: 

A star appears in the bottom right corner of the Status bar. The colors of the stars have different 
meanings: 

o Green: the network connection is currently ok and updates are being transmitted/ received 
o Yellow: the network connection is currently experiencing some slowdowns 
o Red: the network connection is currently in a bad state and is having some connection failures. 

The user may experience an error message if the connection is interfering with a save. 
o Double-clicking on the Star will open the Connection Stats details.  

 Copy-to-clipboard if you want to save/ send the stats in an email (Ctrl V to paste) 
o The Connection star color should adjust to green when the network connectivity improves. It 

may take a few minutes after network improves for the star to change color. 
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 7. REPORTS 

There are various reports based on the data collected in IFM. Most reports can be run for a selected date range.  

 List Exports (All Lists - export to Excel) 

Any Lists can be exported to Excel (e.g.: Incidents, Resources). The export will include the current settings: 

columns selected, column sorting and filtering.   

 Incident Report (Incident form) 

The report contains the latest updates of the information as it currently appears in the Incident form (e.g.: last 

saved changes). Note: to view changes made to incident fields, refer to Incident History. 

o Historical Narratives: All Historical Narratives will be displayed with the date that they were 

saved. Only the last saved narrative per day will be displayed. 

 Incident Status Summary (Incident form) 

This report displays the chronology of the Incident Status changes as they appear in the Status panel of the 
Incident form. Each status change is time-stamped and the size of the fire is captured at the time the new Status 
is saved though they can be edited manually as well.  

 Historical Cost Report (Incident form) 

This report displays any historical and current costs that were entered for the incident as part of the Night 
Report process. These costs are currently manually entered. The user can select the date range that they would 
like to query. 

 Historical Cost Report (Org form) 

This report displays any non-incident costs that were entered for the Area Office as part of the Night Report 
process. These costs are currently manually entered. The user can select the date range that they would like to 
query. 

 Organization Report (Org Form) 

This report gives a snapshot of what is currently displayed in any of the Org form fields. The Area Office Org 
reports have an extra section that includes cost fields. The Daily costs refer to the last submitted costs and the 
Total Costs are calculated since January 1st and then refresh again on July 1st. 

 Incident Log History Report (Log Entry) 

The incident log note history provides a chronology of all of the user-typed log notes and system-generated log 
notes for an incident. Examples of system-generated logs include: assign/ unassign actions and incident status 
changes. Logs for resources that have been assigned to the incident will appear under the incident log as well.  

 Resource Log History Report (Log Entry) 

The resource log note history provides a chronology of all of the user-typed log notes and system-generated log 
notes for a resource. Examples of system-generated logs include: assign / unassign actions, tracking start or stop 
and resource statusing. Any logs for resources that have been assigned to the incident will appear in both the 
incident and resources log history.  

 Area Office Log History (Log Entry) 

The Area Office log note history provides a chronology of all of the user-typed log notes and system-generated 
log notes for an Area Office. Examples of system-generated logs include: assign/ unassign actions and resource 
statusing. Any logs for resources that have been assigned to the Area Office (or any bases that fall under the 
Area Office) will appear in both the Org log and resources log history if not assigned to an incident. If a resource 
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is assigned to an incident, the resource logs will only go under the incident logs and not the Area Office until 
unassigned.  

 Incident Active Duration Report (Log Entry)  

The incident duration report calculates the estimated costs for resources against an incident. This report shows 
all resources that have been assigned to the particular incident.  
The durations are started and stopped by different things for aircraft vs. other resources. Each start and stop will 
show one row and calculation in this report. 
Aircraft: tracking data or user statusing of resources triggers durations 
Other Resources: only user-statusing of resources triggers durations 
Refer to the Resource Duration Report section above for more information.  

 Incident Active Duration Summary (Log Entry)  

The Summary report is the same Active Duration report above, yet is groups rows together for the same 
resource. If you ran the Summary for the entire length of the incident, it would show only one row and 
calculation per resource (e.g.: 5 days rolled into one).  

 Area Office/Station Active Duration Report (Log Entry/ Org Form)  

This duration report calculates the estimated costs for resources against an Area Office/Station. It shows all 
resources that are tagged to a particular Org that are not currently assigned to an Incident (e.g.: out on Patrol).  
The durations are started and stopped by different things for aircraft vs. other resources. Each start and stop will 
show one row and calculation in this report. 
Aircraft: tracking data or user statusing of resources triggers durations 
Other Resources: only user-statusing of resources triggers durations 
Refer to the Resource Duration Report section above for more information.  

 Area Office/Station Active Duration Summary (Log Entry/ Org Form)  

The Summary report is the same Active Duration report above, yet is group’s rows together for the same 
resource. If you ran the Summary for a few days, it would show only one row and calculation per resource (e.g.: 
5 days rolled into one).  

 Resource Active Duration Report (Log Entry) 

The Resource duration report calculates the estimated costs for resources against an incident or Area 
Office/station. This report is specific for one resource, but shows the different Assignments over a time period.  
The durations are started and stopped by different things for aircraft vs. other resources. Each start and stop will 
show one row and calculation in this report. 
Aircraft: tracking data or user statusing of resources triggers durations 
Other Resources: only user-statusing of resources triggers durations 
Refer to the Resource Duration Report section above for more information.  

 Resource Active Duration Summary (Log Entry) 

The Summary report is the same Active Duration report above, yet is groups rows together for the same 
resource. If you ran the Summary for the multiple days, it would show only one row and calculation per incident 
or Area Office (e.g.: 5 days rolled into one).  
 

 Incident Status List Report (Report menu) 

This report displays incident status changes for any incidents by Area. The report shows New Fires, Active Fires 
and Out fires during a specific time period. 

 IA Request Report (IA Request form) 
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This report contains the latest updates of the information as it currently appears in the Incident form (e.g.: last 
saved changes). 
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APPENDIX 

1. Incidents 

2. Organizations 

3. Resources 

4. Quick Picks 

5. User Preferences 

6. Notifications/ Messaging 

7. Historical Incident Data 

8. Resources Provisioning 

9. Export to WFDSS 

10. Quick Keys 

11. Buttons/Icons  

12. IA Request form 

13. Standard Operating Procedures/ Guidelines (To be added) 
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1. Incidents 

Create a new incident: 
1. The toolbar quick button      
2. The log entry form button 
3. File Menu -> New -> Incident 

 Choose which station that the new incident is for. The default will be based on your User Preference. 

 A Smoke Report incident will appear with an auto-generated number based on the station selected 

 The Latitude and Longitude initially default to 53, -148 

 Start typing incident log notes if necessary, before making further edits to the incident form   

 Edit the Incident Number, Latitude, and Longitude 

 Add to your Quick Picks immediately 

 Fill in any other information as it becomes available 
 
Small Incident form in Log Entry: Recommended 

This form is a subset of some of the incident fields from the large incident form. The idea is that users can 
quickly create new incidents in the log entry and type log notes for the incident immediately. 

 In Log Entry form, type initial incident details in your station log 

 Highlight the log and hit 'Ctrl C' to copy from the Log History 

 Hit New Incident button 

 The new incident will be created and will be selected in the log entry 

 Paste any copied logs (Ctrl V) 

 Type log notes as necessary (directions, reporter info, etc) 

 Open the bottom panel of the log entry and edit the incident information as necessary 

 The fields in the log entry incident panel will match the main incident form as long as it is saved! 
 
Submit a Night Report: 

 There are two indicators if a Night Report is required: 
o Incident List = incident is highlighted brown 
o Night Report panel of incident form says 'Yes' 

 To submit a Night Report, hit the Complete button in the Night Report panel 

 A validation message will indicate if any of the mandatory values have not been filled in 

 Fill in the mandatory values  
o You can enter 0s if necessary 
o You can enter negative cost values to subtract from the Total costs if necessary 

 Click Complete again until there are no longer validation issues 

 Note: a Night report can be completed multiple times in a day, with the final 'Complete' overriding 
earlier values 

 
Finalize an Incident: 

 After the incident is called Out it must be reviewed to ensure the information is correct 

 Ensure that the Total Size in the Land Status panel is the same as the Current Size 

 After review, go to the Incident Details panel 

 Fill in the field called 'Final Fire Report Approval' with your name 

 In the General Panel, change the Incident 'Status' to Finalized 

 Click 'Save' 

 Note: Finalized incidents do not require Night Reports 
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Assigning or Unassigning Resources: 

 See Appendix 3. 
 
Incident History/ Changes to incident data: 

 Launch the Incident History viewer from an incident form  

 Choose a saved setting from the dropdown menu (viewer toolbar) 

 Sort the results by the 'Last Update Time' column 

 Adjust the visible columns using the column selector if necessary 

 The history of changes to the incident fields will be represented by each specific column 

 Add the 'Updater' column if you want to see who made the changes 
 
Email AAO: 

 The incident form has a button to generate an email with incident information 

 Choose the 'Email Incident Details' dropdown option   

 An email should open with a subset of data from the incident form 

 Enter an email address or multiple addresses and SEND 

 Note: the email also contains a web-link to Mobile IFM for that particular incident 
 
Email Land Managers: 

 The incident form has a button to generate an email with incident information 

 Email addresses are auto-filled based on the ADMIN UNITS selected in the Land Status panel. The email 
addresses associated with an Admin Unit can be added or edited via Provisioning (File > New Resource) 

 Choose the 'Email to Land Manager' dropdown option   

 An email should open with a subset of data from the incident form 

 Enter an email address or multiple addresses and SEND 

 Note: the email also contains a web-link to Mobile IFM for that particular incident 
 
Attachments panel: 

 Attachments can be uploaded to the incident form in any size or file format  

 Try to be conscious of file size (e.g.: 100,000kB) when uploading 

 The file is stored on a server in Anchorage, so can be deleted from your computer if desired 

 If the attachments server is unavailable, there will be a warning to the users 
o Any previously attached files will not be available until the server is connected 

 
 

2. Organizations/ Bases 

 
Submit Nightly Costs for an Area Office: 

1. Open the Area Office form in IFM 
2. Enter the values in the 'Additional Info panel' 
3. Enter a Cost Comment 
4. Hit Completed 
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Station Logs:  

 Station logs can be captured throughout the day for any occurrences. Some examples are: phone calls 
reporting incidents (create an incident as soon as possible), general phone calls, or anything to be 
documented that does not directly pertain to an incident or resource in IFM.  

 
Extended Staffing:  

 Alert Schedule field: record daily extended staffing and utilize this formatting: "20:00 03/15/13" 

 Prep Details: list resources to be extended: "2 engines, tankerbase, helitack, 2 dispatchers" 
 
Duty Officer Roster: 

 Details field: list the Duty Officer on call with their contact info: "03/15-22/13 Ron Boyd 333-1120" 
 
Responsible Org: 

 Home Unit: where a resource is based out of generally (eg: tankers may have 'Alaska' whereas 'F-68' 
would have 'Fairbanks' 

 Current Assignment: where a resource is temporarily based out of (e.g.: tankers may have 'Home = 
Alaska and Current Assignment = Palmer TB') 

 Responsible Org: if a user has a Current Assignment, that is the Responsible Org. If a user does not have 
a Current Assignment, the Home Unit is the Responsible Org. 

 
Set a Current Assignment (Org) for a Resource:  
There are a few ways to tag a resource to an Organization (Area Office, Base) 

1. Drag resource(s) onto the Org in the Quick Picks if not assigned to an incident 
2. Enter resource callsigns in the Resource panel of the Org form and Save 
3. Select the resource in the Log Entry and use the Assignment field to tag it the Org (save or Enter) 

 
Remove a Current Assignment (Org) from a Resource: 
There are a few ways to remove a resource from an Organization (Area Office, base) 

1. Open the resource form Association panel and change the Home Unit or Current Assignment as 
necessary > Save 

2. Drag resource(s) onto a new Org in the Quick Picks if not assigned to an incident 
3. Highlight the resource in the resource panel of the Org form. Hit Unassign and save 
4. Select the resource in the Log Entry and delete the Org from the Assignment field (save or Enter) 

 
Move a Resource icon to an Organization icon: 

1. Assign a resource to an org (above) 
2. Click on the resource in the resource table 
3. The resource line should turn grey to indicate it is selected 
4. Click on the blue ‘Move-To’ arrow 
5. The text should turn pink to indicate the resource has moved 
6. The Resource flag will appear above the organization flag to indicate it is stationed there. 
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3. Resources 

New Resources are created and existing resources edited though Resource Provisioning. 
 

Resource Assignment: How To 
 

Assign a Resource through Quick Picks: 
1. Ensure that your incident is in the QP form 
2. Highlight the resource in the QP form or Resource List. (Hold Ctrl key to highlight multiple resources.) 
3. Click again and Drag the selected resource(s) over the Incident in the QP and drop 
4. The resources will now be Assigned to the Incident 
5. (You could also drag the resource into the Resource panel of the incident form) 

 
Assign a Resource through Log Entry: 

1. Select the resource in the Selection field of the Log Entry (hit F3 and type callsign) 
2. Tab over to the Activity field and type the incident number (or last couple digits) 
3. Hit Enter 
4. The resource will now be Assigned to the Incident 
 

Assign a Resource through Incident form: 
1. Open the Resource panel of the incident form 
2. Type the resource callsign in the dropdown box and hit Assign 
3. Type more resource callsigns if necessary 
4. Hit Save to complete the Assignment 

 
Assign a Resource through Resource form: 

1. Open the Associations panel of the Resource form. 
2. Select the Incident in the Incident field or change the Home Unit and Current Assignment as necessary > 

Save 

 
 
 
Resource Unassignment: How To 
 
Unassign a Resource from an Incident: 

5. There are a few ways to Unassign a resource from an Incident 
1. Right-click the resource in the Quick Picks > Unassign 
2. Right click on the Assigned resource in the Resource List > Unassign 
3. Highlight the resource in the resource panel of the incident form. Hit Unassign and save 
4. Select the resource in the Log Entry delete the Incident from the Assign field 

 
Resource Assignment: About 
 

Figure 1A: Association Panel of the Resource Form 
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 Assignment = Incidents, Detection or Pre-position in IFM.  

 Assigning means that the resource is currently tagged to that assignment and any logs and statusing will 
be captured as part of the chronology for the assignment. This is different than 'Committing' resources 
as in ROSS. These resources can be re-Assigned as necessary.  

Icon Move: 
If a resource does not have a functional tracking device, you can update a resource icon location in four 
ways: 
1) Move in Quick Picks or Resource List 

 Right-click on the resource in Quick Picks or Resource list 

 Select Move and choose one of the options (Home Unit, Current Assignment, Incident, Set Lat 
Long) 

2) Manually setting the resource's Latitude and Longitude 

 In the resource location panel, place your cursor in the Latitude field 

 Enter a valid Latitude and Longitude > Save 

 The resource should move to the new location 
3) Using the Latitude/ Longitude selector 

 Click on the Lat/Lon selector icon   

 It should turn green to indicate it is activated   

 Click somewhere on the IFM map 

 The coordinates should update and the resource should move to the new location > Save 

4) Using the Move buttons in the Log Entry, Incident form, Resource form   

 Click on the button beside a location to move that icon on the map 
 
Resource Tracking: 

 Tracking: signifies an update to the Position of the resource icon by the tracking device. When the 
tracking device is turned on for a resource, the resource flag turns from black to a solid colour (yellow, 
green, blue) depending on the resource's availability. As the resource moves, positions and statistics 
(speed, heading, altitude, etc) are captured at an average of one every two minutes.  

o Note, when creating a new resource, the position will also update (which looks like tracking). 

 Tracking Issues:  Contact the communications manager if resources are not tracking and should be.  

Tracking History: 

 All past resource positions are captured and archived. These past positions can be viewed on the map by 
enabling the History. Users can choose to look at a past date range, or view the current position trail 
(e.g.: '25 positions' filter will update as new positions are captured). The trail will appear on the map as a 
series of yellow dots connected by yellow lines.  

 The historical position table on the resource form displays the past tracking information and matches 
the history currently displayed on the map. The information can be copied row by row and pasted into 
resource logs for example.  

 Use the  button to unload the tracking history from your form and map. This can be done by clicking 
on the yellow tracking dots on the map and one of the tooltip positions to open the form where the 
button is found. 
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Resource ICS Statuses 
 
There are three ICS statuses:  

 Assigned = Incidents, Detection or Pre-position in IFM.  
o When a resource is Assigned to an incident; any status 

 Available = resource is available for duty and not currently Assigned 
o When a resource is Unassigned; status is Patrol, At Base, Idle, On Scene 

 Out of Service = resource is unavailable for duty or assignment (e.g.: gone home for the night, on 
holidays, undergoing maintenance) 

o When a resource is Unassigned; status is Off Duty  

 Assigning means that the resource is currently tagged to that assignment and any logs and statusing will 
be captured as part of the chronology for the assignment. This is different than 'Committing' resources 
as in ROSS. These resources can be re-Assigned as necessary.  

 

Resource Statuses: 
Resource status refers to what the resource is currently doing (actions such as Patrol or En route to incident). 

STATUS EXPLANATION 

AT  BASE Resource is stationed at a base.  (Clears check-in) 

ENROUTE Resource is en route TO or FROM an incident, detection or preposition. Resource 
must be Assigned. 

PATROL Resource is out on Patrol and is not currently assigned to an incident. 

ON SCENE Resource is On Scene at an Incident. 

IDLE Resource is not currently contributing to a duration or cost estimate. (Eg: a heli that is 
landed out at a fire or crew that is over-nighting).  

OFF DUTY Resource is not currently available for a dispatch. (ICS status changes to Out of 
Service if Unassigned).  (Clears check-in) 

 

 

Resource Durations: 

 Durations: a resource is actively generating time against an incident or area office/ station. An estimated 
cost can be generated from the duration time x hourly rate (Active Duration Report & Summary).  

 Durations are generated differently for aircraft vs. other resources. 

Figure 2A: History Panel Layout 

Table 1A: Resource Statuses 
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 Aircraft durations are triggered by two things: 
o Resource tracking devices: When a tracking device fires up, the duration starts. When the 

tracking device has not had a position for more than 10 minutes, the duration stops at the time 
the last position was received. E.g.: aircraft flies from base to incident and lands = duration. 

 Note: the 'Tracking Stopped' event is inserted into the Log History, even when the 

resource is actively tracking. The log's timestamp is updated with each new position 

update. 

o Resource Statuses: Certain statuses that start and stop resource durations. These statuses are 
set by users. See table below. 

o The duration start and stop is triggered by whichever of the two things happens first, the 
tracking device or the resource status change. 

 Other Resource durations are triggered by one thing: 
o Resource Statuses: Certain statuses that start and stop resource durations. These statuses are 

set by users. See table below. E.g.: engine is put in 'Patrol' status for the day. When they are 
changed to At Base, the duration is complete. 

 

RESOURCE STATUS: Start Duration? Stop Duration? 

AT BASE NO YES 

ENROUTE YES * NO 

PATROL YES * NO 

ON SCENE YES * NO 

IDLE NO YES 

OFF DUTY NO YES 

* If the Duration is already in progress, choosing this Status will continue the duration and not restart it. 
 

 Resources that are not assigned to incidents will have their Durations and logs show up under a Current 
Assignment or Home Unit (Org). 
 

Resource Assignments and Durations: 

 New Resource Assignments do not automatically start a Duration. It depends on the Resource's status or 
tracking.  

o If the aircraft is tracking, the duration will start against a new assignment.  
o If the aircraft is not tracking, the new assignment will not start a duration. 
o If the current resource status is generating a duration, the new assignment will start a new 

duration.  
o If the current resource status is not generating a duration, the new assignment will not start a 

duration. 

 If you assign a resource that is out on Patrol, the resource duration will start against the incident as soon 
as it is Assigned. The resource status will automatically change from Patrol to En route. 

 If a resource is currently Assigned to an Incident (and their status = En route or On Scene), the duration 
will stop against the first incident and start against the new incident if the resource is reassigned. The 
status will automatically change to En route on reassignment. 
 

 Duration Reports: These reports show the resource time durations from the start to stop (status or 
tracking). The durations are multiplied by the hourly resource costs. 

Table 2A: Durations triggered by Statuses 
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1. Incident/ Org Active Duration Report - Displays each duration segment (start and stop duration) 
for every resource that had a duration while Assigned to the Incident or Station in the selected 
time range. 

2. Incident/ Org Active Summary - Summarizes the duration segments so there is only one per 
resource for the selected time range. 

3. Resource Active Duration Report - Displays each duration segment (start and stop duration) for 
a specific resource in the selected time range. 

4. Resource Active Summary - Summarizes the duration segments so there is only one per 
resource per Assignment or Area office. 

Resource Contracts: 
There are three different Contract types for resources: 

 On Contract - State resources, other hired resources, short term or long term hire. 

 Off Contract - Any resource not currently on staff or temporarily hired. 

 For Hire - A resource that is Off Contract, but has indicated that they are available for hire. 
 

Choosing the resource Contract will not impact the Resource Status or ICS status. It is best displayed in the 
Resource List by enabling the 'Contract' column and filtering accordingly.  
Changing the Contract for a resource can be done in a few different ways: 

1. Right-click on the resource(s) in the Resource List 
2. Right-click on the resource(s) in the Quick Picks 
3. Edit the resource form Status panel 

Resource Icon Filters: 
From the icon overlay tree, select which Types of aircraft that you would like to see on the map (e.g.: tankers 
and/or medium helis). To further filter the resources, use the Filter button in the toolbar. 

o  - Launches the resource icon filter options 

o  - Allows the user to choose any of the various filter options. E.g.: View Active (tracking) resources 
that are Available ICS status 

o  - Apply the filters that are selected 

o  - Remove any filters from the filter view. Hit apply. 
 
 
 
 
 
 
 
 
 

4. Quick Picks 

Quick Picks is a form or window that offers a snap-shot and quick access to important resources, incidents or 
stations. The form is split in to three sections: Incidents, Resources and Orgs.  

Figure 3A: Resource Icon filter 
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 Users should build and maintain their Quick Picks to show anything that they want to have quick access 
to for status updates or log notes. Each user's Quick Pick can be unique. It is recommended that users launch 
and maintain their QP daily.  
 
 
Default Quick Pick: 
The QP form has a default size and layout, which can be adjusted by each user.  

There is a column picker to the left of each section  to add or remove 
columns. The Quick Pick will open in the same location and with the same 
settings and selections unless it is moved or changed by the user.  
Recommended default columns include: Incident Number & Status; Resource 
callsign, Incident and Status; Org Name (see Figure 4A). 
 
Maintaining your Quick Pick: 

 Adding to QP: 
o Quick Pick: Type the Incident, Resource or Area Office in the text 

field at the top of the QP. 
o Lists: Highlight the selections in the Resource or Incident Lists. 

Drag the item(s) to the correct section in the Quick Picks and 
release the mouse.  

o Forms: There is a pink 'Add to Quick Pick' button in each form and 

on the log entry.  

 Deleting from QP: 
o Highlight the selection(s) in the QP and hit the Backspace, minus (-) key, or Delete key 
 

Using the Quick Pick:  

 Log notes: Double click on any item in the Quick Picks to open the Log Entry form. Highlighting the 
item and hitting 'L' will also open the log. 

 Multi-select: hold the Ctrl key to select more than one Resource, Incident or Org in the Quick pick. 
Actions can be done for more than one item at a time. 

 Opening forms: Highlighting the item and hitting 'O' will open the selected form. 

 Assignments:  Click & Drag the resource(s) from the Resource section and drop 
them on the Incident. That will trigger an Assignment. Re-assignment can be 
done by dragging the same resource(s) to a new incident in the QP. 

 Resources Status: Right-click on any Resource(s) in the QP to change their 
status.  

 Alert Status: Right-click on any Resource in the QP to set the Alert status. Alert is 
mainly used for tankers and crews to indicate their response times (red, blue, 
green, and yellow).  

 Edit Schedule: Right-click to edit the Schedule field for the Resource(s) selected 

 Contract Status: Rick-click to change the Contract to: ON, OFF, FOR HIRE 

 Resource Moves: Right-click on any Resource(s) in the QP to move the icon on the map. The 
available options for moving each resource include: the Home Unit, Current Assignment or Incident 
if applicable. 

  
 

Figure 5A: Resource right-clicks 

Figure 4A: Quick Pick layout 
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5. User Preferences 

Users are encouraged to set up their Preferred base or office using the File menu. The selected preference will 
auto-fill when creating new incidents and it will also ensure that Alaska appears at the top of some dropdown 
menus (instead of other agencies). 
 
User Preferences also refers to IFM remembering certain preferences around set-up, forms and lists.  
 
User Preferences Remembered on Initial Launch: 

 Location of application - the IFM map will launch in the same place it was sitting when IFM was exited.  
If the user has multiple monitors, it will launch on the correct monitor. The map size will also be 
remembered. 

 Beeping - beeping will be enabled or disabled based on what you had previously selected  

 Forms open/ closed - any forms that were open when you exited IFM will launch 

 Lists open/ closed - any lists that were open when you exited IFM will launch 

List Preferences 

 Filters - your filter settings are remembered for each List (e.g.: filtered by Fixed Wing resources) 

 Columns selected -  which columns are displayed or hidden is remembered along with the column 
order and width 

 Panels - whether panels are expanded or retracted is remembered 

 Location of your List - the location of your different Lists is remembered based on your computer 
monitor configuration 

 Size - the size of your List window is remembered 

Form Preferences 

 Panels - whether panels are expanded or retracted (on applicable forms) is remembered 

 Location of your forms - the location of your different forms is remembered based on your computer 
monitor configuration 

 Size - the size of your forms is remembered 

Quick Pick Preferences 

 Location and size  - the location and size of your Quick Picks is remembered based on your preferences  

 Columns and Sort order – remembers the last state of the columns, column size, and sort order of the 
columns within your quick picks 

 Items within the Quick Picks – will remember all items you had added to your quick picks 

Reset User Preferences 
The File menu offers the option for users to reset their Preferences to the default settings for the application. 
Here are some examples of what is reset: 

 Forms -  will not automatically launch when the application is launched 
o forms will launch on your main monitor in the middle of the screen 
o form sizes will reset to their default size 

 Lists - any set List filters will clear so that Lists will be unfiltered 
o selected and hidden List columns will be reset as well as the column order 

 Maps - any saved maps are discarded with only the Default map remaining 

 Application Location - the Default map will launch on your main monitor with no other forms opening 
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6. Notifications/ Messaging 

Notifications refer to different indicators that user attention should be drawn to. A notification can be the 
flashing an icon on the map, a pop-up window, or warning prompt. 
 
Messaging and Log Notifications 
Users can send messages to other stations through IFM. These messages can be typed manually or can be 
forwarded from the log history if already entered. The users get a notification that their station has a new  
Message if they are logged in to IFM. 
 
Sending a Message: 
There are two ways that a Message can be sent to another station: 
 
1. New Message: 

 Send a New Message: 

o Select the Message icon  from the toolbar or hit 'Ctrl M' on your keyboard 

o The Message form will open (Figure 6A). Choose the Station from the dropdown that you would 

like to send the Message to. You can type the name, partial name or use the dropdown. 

o Choose any other Stations that you would like to send the Message to if applicable. 

o Type the message or copy it into the large text field  

o Hit Send  

2. Send a Message from the Log History: 

 Forward Message:  forward an existing log from log history 

o Right-click on any existing note in the Log History that you would like to send as a Message. 
o Choose 'Forward' 
o Fill in the 'Message To' field with any stations 
o The text field will be auto-filled 
o Hit Send 

 Reply to Message: respond to a station who has sent a log or message to your station 
o Right-click on any green Message or note in the Log History that you would like to Reply to. 
o Choose 'Reply' 
o The 'Message To' field will be auto-filled with the Station that sent the original Message 
o Fill in the text field with the Reply Message 
o Hit 'Send' 

 
 
 
 
 
 
 
 
 
 
 

Figure 6A: Message form 
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Receiving a Message: 

 Notifications of New Messages: 

Messages for stations appear in the log history for a particular station log and they will be colored in bright 
green. Each user is generally set up so that they have a Station/Org selected in their User Preferences.  This 
selection will indicate the station for which the user receives notification of Messages.  
There are two forms of notifications so that users know when their station has received a new Message or has 
unread Messages.    

1. Fading Notifications: 

 In the top right corner of the main monitor, a fading notification will appear when your station 

has a new message 

 The fading message will stay for a few seconds 

 Put your cursor over the notification for it to remain visible 

 Click on the message to open the log history, filtered to view only your station messages 

2. Status Bar icon: 

 The icons in the status bar indicate if a station has any Messages that are unread.  

 The envelope icon will have a green background and a number beside it. 

 Clicking on the status bar icon will open the station log history, filtered to view only your station 

messages  

 

 Reading Messages:  

Station Messages will show up green in the log history and status bar until a user selects 'Mark as Read'.  It is 
important to note that a Message has been viewed, so that other users in your station are aware, and so that 
the sending station is aware. 

o Right-click on the green Message in the Log History    

o Choose 'Mark as Read' 

Once one user selects 'Mark as Read', that green Message will turn in to a regular white log note in the log 

history. You can enable the 'Station Message' column if you ever want to know if something was previously a 

message. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 7A: Unread Messages in the Log History 
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Send Log Notes (non-message):  
Messages are different than regular log note. It is possible to send regular log notes to Stations. These log notes 
appear in the Station log history as regular white log notes.  

o Select the Message icon  from the toolbar or hit 'Ctrl M' on your keyboard  

o Fill in the 'Log To (CC)' field with the station(s) 

o Fill in the text field with the log note for the station 

Note: You can fill in the 'Log To (CC') field at the same time as sending any Message.  
 
Receiving Log Notes (non-message): 
There is one indicator that a station user has some log notes that are unread. These log indicators are user-
specific and they do not need to 'Mark as Read'.   

1. Status Bar icon:  

 The status bar will show a user how many user-typed log notes have been entered for their 

station since the station log was last opened or since IFM was launched 

 Clicking on the status bar icon will open the station log history, filtered to view only your station 

messages 

 
Overdue or Lost Tracking Resources (Alarming Resources) 
There is a special status bar icon to indicate when there are resources that are either overdue for a check-in or 

have lost tracking (no new tracking position for more than 10 minutes).    The pink icon will show a 
number for the resources in IFM that are in those states. Clicking on that icon will open a filtered list (Figure 8A).  
 

 
 
 
 
 
 
 
 
 
 

Figure 8A: Alarming Resources 
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7. Historical Incident Data 

For Incidents in IFM, only the current year's data will show by default.  
Historical data from previous years can, however; be accessed at any 
time. 

 
Load Historical Incidents: 

 File menu -> Load Historical Data -> Incidents 

 A date range selector will pop-up and allow you to choose the 

historical range that you wish to see. Hit 'Load' 

 
 When loaded, Historical incidents will appear in the Incident List. They will also appear as icons on the 

map. 

 Note: all current year incidents will show up no matter what Historical date range is selected 

 

Historical Incident Logs: 

 Historical incidents cannot be selected in the Log Entry. They do not appear in the dropdown for 

selection. To open Historical incident logs, first open the Historical incident form (from icon or List), then 

hit the Open Log button from there   

Unload Historical Incidents: 

 Historical incidents will automatically disable the next time that you launch IFM.  

 To unload historical incidents within your current session, re-open the date range selector (via File -> 

Load Historical Data). Hit 'Unload' 

 
 
8. Resource Provisioning  

Resource provisioning is where IFM users can create, edit, and Archive 
resources as well as important information with regards to resources (e.g. 
Carriers, Position Provider, Resource Types, etc.). Resource Provisioning is 
accessed via File -> New -> Resource and opens in your web browser. 
There are three types of user privileges in IFM, so not all users will have the 
same editing capabilities. 

 User/ Dispatcher 

 Admin 

 Maintainer - Selkirk staff at present 
 
Resource Provisioning - Admin: 
With the Admin privileges, this user has the ability to add and edit the following: 

 Resources 

 Carrier - company/owner 

 Make/ Model 

 Position Provider - company supplying tracking device 

Figure 10A: Resource Provisioning Dashboard 

Figure 9A: Historical incident selector 
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 Admin Unit - Incident form: land status panel  
 

The Provisioning dashboard is along the left side of the screen. Each option has two icons: List   and New 

 . Clicking the List icon will display a list of all of the existing items of that type. Clicking New will allow you 
to create a new item of that particular type. 
 
Lists: 
The lists will sort by the first column though clicking any header will resort. The Lists will display all of the 
current items of the selected option (e.g.: Resource, Make Model, etc) with some of the attribute data.  

 Searching Lists: 
 For each list there is a Search field where users can search by most columns. The number  of 
matches will  appear above the list. To clear the search and return to the entire list, simply click 'Clear Results' 
 above  the search field. 

 
 
 
 
 
 
 
 
 
 
 
 
Editing Existing items: (Resources, Carriers, Make Model, and Position Provider) 
To make any edit in Provisioning, go to the appropriate List and search for the item. Select it from within the 
lists and a new page should appear with 'Edit' as an option at the bottom. Click on 'Edit' and all of the fields 
in your selection should become editable. Click 'Update' at the bottom of the page once your edits are 
complete or 'Cancel' to disregard any changes. 
 
Create a New Resource: 
Before creating a new Resource it is recommended that you 
search the unfiltered IFM Resource List (List -> Resources) to 
ensure that the resource does not already exist.  
It is also a good idea to ensure that the resource is not 
‘Archived’ through Provisioning. (Sort the Resource list by the 
'Archived' column. 

 To create a new Resource, click on the 'New Resource' 

icon on the dashboard . You can also choose File > 
New > Resource in IFM which opens your web browser. 

 A 'Create Resource' page should appear.  

 Mandatory fields: The Callsign, Registration, Type, and Home Detachment (highlighted pink). If any 
mandatory fields are not filled in, you will get a validation error in red text.  

 Other fields can be left empty or filled in later as necessary. The fields are what populates the 
Resource form in IFM. 

 

Figure 11A: Make Model list sample 

Figure 12A: Editing items in Res Prov 
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 Tracked Resources: 
If the resource has a tracking device, the yellow highlighted fields are required to be filled in. Note: the 
tracking device company will have to be notified to ensure the positions for a particular resource are being 
fed in to IFM. 
 
 Misc Notes for Resource Creation: 

 When selecting a 'Type', you must select the lowest level sub-type (e.g. if the list contains Aircraft > 
Rotary Wing > Intermediate, you must select 'Intermediate').  

 The check-in field represents the 'Default check-in time' visible in the log entry form. It should be 
entered in minutes, or a 0 should be entered. You can also choose to inherit the same default 
check-in time that is associated with that Resource Type. 

 Hourly Cost: populates the Duration reports  by multiplying by the Duration times  

 Image:  can be saved to your computer and then uploaded using the Browse button. The image 
does not need to remain on your computer after the Upload is complete.  

 Home Unit: choose main base for that resource 

 Username: not necessary to fill in 

 If you are unable to find the desired Make/Model, Carrier or Provider, your account privileges will 
allow you create new ones (save the resource first). 

 Any new resource will appear at the default coordinates upon creation: 57 x -157 
 

Create a New Carrier: 
To create a new Carrier, click on the 'New Carrier' button on the 
left-hand side of the provisioning page.  A 'Create Carrier' page 
should appear. There is only one field, the Carrier Label that must 
be filled in.   
 
Create a New Make Model: 
To create a new Make Model, click on the 'New Make Model' 
button on the left-hand side of the provisioning page. A 'Create Make Model' page should appear. There are 
two fields and both must have a value in order to create a new make model. Note: the Make/Model field is 
dependent on the Resource Type selected. 

 

Create a New Position Provider: 
To create a new Position Provider, click on the 'New Position Provider' button on the left-hand side of the 
provisioning page. A 'Create Position Provider' page should appear. All four fields displayed need to be filled 
in though they currently do not currently hold value (can put in any info for the 'Query fields).  
 
Admin Unit: 
Admin Units appear in the Land Status panel of the 
incident form. They indicate land ownership for the area 
impacted by a wildfire. An email can be associated to the 
Admin Unit via the Provisioning tool. If the 'Email to Land 
Managers' button is used on the incident form toolbar, 
an email is auto-populated with incident details and the 
email address provisioned for the Admin Unit(s). 
Note: Multiple email addresses can be saved through Provisioning.  Edit the Admin Unit and enter multiple 
email addresses with a 'comma + space' in between (Figure 14a).  

Figure 13A: New Make Model 

Figure 14A: Admin Unit emails  
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Archiving: 
It is not possible to delete resources or any of the dropdown options completely out of IMF, but it is 
possible to Archive. Archiving allows the resource or item to be un-archived later if necessary and previous 
data history is maintained.   
Archived items can be found in the Provisioning pages at the bottom of the Lists by default. Users can also 
search for them by enabling the 'Include Archived' checkbox. If a resource is archived, it will no longer 
appear in IFM at all. If a dropdown option is archived, it will no longer be available to select when creating 
or editing resources. It will disappear if it is already selected and saved for an existing resource. 
To Archive, edit a resource or dropdown option listed above in the Provisioning pages. Ensure that the 
checkbox beside 'Archived' is selected and Save. To Un-Archive, select the same checkbox and ensure that it 
is empty before saving. 

 

9. Export to WFDSS 

Users can choose to export their IFM incident information directly into WFDSS, instead of going into WFDSS and 
manually entering all of the incident data. An advantage to doing the export via IFM is that the data is pulled 
directly from the IFM incident form. Also, updates to the Incident form in IFM are captured in subsequent 
WFDSS exports if the incident originates in IFM. The updates do not occur if the incident is first created through 
WFDSS.  
 
The Export will be done once per day by Intel, unless otherwise requested from a Landowner. If requested, 

follow these steps:  

1. File > Export to WFDSS 

2. Select a specific date range if necessary; otherwise use the 12H quick key. 

3. Save the .psv file on your desktop or in a folder on your computer 

4. Login to WFDSS if/when prompted 

5. Select 'Incidents' and 'Upload Incident'  

6. Select SELKIRK and Browse to the .psv file > Upload 

7. Verify that your incident was successfully uploaded to WFDSS by checking the 'Recent Incidents' filter 

 (which is a bit finicky). For the WFDSS Incident filter, you may have to wait a few minutes for your 

 incident information to upload. Try selecting a few filters and then return to 'Most Recent Incidents' 

 filter. 
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10. Quick Keys 

Here the quick keys to help use some of the functionality. 

 

HOT KEYS DESCRIPTION 
F3 Opens Log Entry from. 

Empties Log Entry selection. 

Enter Save log changes (with check-in) in Log 
Entry 

Alt S - Save log changes (without check- in) in Log 
Entry form 
- Draw curve distances with measure tool 

Ctrl A Highlight text 

Ctrl C Copy text 

Ctrl V Paste text 

Ctrl M Send Messages 

Ctrl Q Open Quick Picks 

Shift + Click Enables/ Disables all icons below in the tree 

Shift + Click Pans around the map without  selecting pan 
tool 

O Opens the form for a selected item in the 
Quick Pick table or List. 

L Opens the Log for a selected item in the 
Quick Pick table 
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11. Icons and Buttons 

BUTTONS / ICONS DESCRIPTION 

 
Back/ Forward: allows users to move through the map history 

 
Reset Map: resets map to last saved state 

 
Turn On/Off Legend: retracts or expands the Icon and Map overlay legends 

 
Turn On/Off Icon Flags: when the map gets cluttered with icons (turns off all 
flags except for resources) 

 
Pan: used for navigating around the map area at the same zoom level 

 
Magnify: alters the map scale by zooming in or out 

 
Measure: ability to measure lines, areas or curved lines (Alt S) on the map 

 
Select: used for opening up detailed information for icons displayed on the map  

 
Quick Picks: a pop-up that allows the user to have quick access to their Incidents, 
Resources and their Base logs and forms. 

 
Location conversion (LOCO): allows user to convert between various coordinate 
formats and perform a Google location search 

 
Bearing & Distance: used for determining the bearing and distance from a 
specified icon to a specified location on the map 

 
AFS map engine: various map overlays provided by AFS  

 
Selkirk map engine: basic map overlays 

 
GINA map engine: SPOT5 - 2.5m imagery for most of the state. 

 
Google Earth: launches Google Earth in the web browser 

 
Create a new incident: opens empty incident form  

 
New IA Request: creates a new IA Request form 

 
Log Entry form: a place to enter radio logs for Resources, Incidents or Area 
Offices 

 
Send Message:  opens an empty form to send a Message to another station 

 
Open Prep List: launches Org List filtered and set-up to view the Prep data 

 
Reports: launches various pdf reports from other forms (eg: incident) 

 
AFS map legend: a map legend based on what map layers are currently enabled 

 
Save with Check-in: saves changes  and updates the check-in time (if there is a 
default set) 

 
Save without Check-in: saves changes without updating the check-in time (if 
there is a default set) 

 
Revert: reverts any unsaved changes 

 
Center Map: centers the map on the icon that is associated with the form that is 
currently open (note must enable icon type) 

 
Crosshairs: puts red crosshairs on the map to show the icon location 
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Add to QP: this button adds the Incident/ Resource to the Quick Pick List from 
the form 

 
Move to: moves the Resource to the Incident or Base location (as listed in the 
field beside) 

 
Open Resource Form: opens the resource form for the resource currently 
selected in the log entry 

 
Open Incident Form: opens the incident form for the incident currently selected 
in the log entry 

 
Copy to TTY: copies a few defined fields to the clipboard in order to paste them 
in the TTY (Ctrl V) 

 
Opens an email pre-populated with incident form details 

 
Open incident History viewer: shows all changes for all fields on the form 

 
Add file/ Add Row: attach a file to the incident form (uploads to remote server) 
or Add a new row to a table 

 
Remove file/ Remove Row: removes an attachment from the incident form or a 
Row from a table 

 
Open file: downloads locally, prompts to save, then opens the file 

 
Deletes the Incident form (should only be used when incident is created by 
mistake) 

 
Filter: opens the List filter or  

 
Add filter: choose which filter options you would like to use 

 
Remove filter: remove certain selections from your current filter 

 
Apply filter: apply current filter selections to your list/ resource icon overlay 

 Column selector: choose which columns to appear in a List/ Table 

 
Show Duration Events: filters the Log History to show resource statuses that 
trigger durations to start or stop 

 
User Entered Logs: filters the Log History to show only user-typed log notes 

 
System-generated Logs: filters the Log History to show only system-generated 
log notes 

 
Set Lat Lon: fills in the coordinates based where you have clicked on the map 

 
Lock Coords: the lat and long fields become un-editable on the incident form  

 
Retract all panels: quickly close all panels 

 
Unload History: Remove resource history trail from the map 

 
Opens a List of resources that are due for a check-in or have recently stopped 
tracking 

 
Displays the number of entries in your station log since it was last opened 

 
Displays the number of Unread Messages for your station (click to open view) 

 
Opens the Log Viewer List 

 Connection Status: Green = good connection, Red/ Yellow = unstable connection 

 Sets the nearest weather station in you Incident Site Info panel in the ‘Station’ 
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field 

 
Updates your field(s) with site data information from your map 

 
12. IA Request form 

IA Requests can be generated for any situation where Initial Attack resources are required (e.g.: Smoke Jumpers, 
tankers). The Request can be generated at one Station and sent to another, with an audible alarm notifying the 
suggested recipients.  

 
Set up: 

 Select your User Preference (File -> User Preference -> Save) 

 Enable IA Request icons in your icon overlay tree (Active).  

 Enable Beeping:  Beeping -> IA Request -> Everywhere.  
 
IA Request fields: (* = default) 

 Incident number = mandatory field (where the coordinates come from) 

 Priority = taken from the Primary Protection level on the incident. Note, if this changes for the incident, 
it will not automatically update for the IA Request. 

 Status = Requested*, In Progress, Denied, Cancelled, Complete 

 Request = Fire #*, ASM, Jumpers, Retardant, Other 

 Responsibility = where the Request update is directed (e.g.: Statewide Tactical*, Palmer TB, etc). It will 
beep for anyone with that Org selected in their User Prefs (must have Beeping menu enabled) 

 Detail = a text field to enter any specifics about the Request (e.g.: "4 loads of retardant") 
 
IA Request Status: 

 Requested = an initial IA Request status to show that it is not yet being actioned/ filled 

 In Progress = the Request is currently being actioned/ filled. Changing any Resource Task Status to 'In 
Progress' will change the IAR status to 'In Progress' or it can be manually adjusted. 

 Completed = the Request has been complete. Changing the IAR Status to Complete will change any 
resources to Complete & will Unassign from the Incident. 

 Cancelled= the Request is no longer required. Changing the IAR Status to Cancelled will change any 
resources to Cancelled (Unassign). 

 UTF = the Request cannot be filled. Changing the IAR Status to UTF will change any resources to UTF 
(Unassign).  

 
Create a New IA Request: 
There are two ways to initiate an IA Request: 

1. From the Toolbar or File menu (File -> New)   
o Must choose an incident before saving    

2. From an existing Incident form  
o Auto-fills the incident number 

Fill in the Request and Responsibility (who should Acknowledge the Request).  The Responsible Org will show up 
in the flag text (e.g.: KKS above).  
Note: any changes to an IA Request must be Saved in order for them to be reflected.  At that time the Request 
will flash on the map, and ding for any users where the Responsibility field matches their User Preference 
selection. 
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An IA Request must be associated with an incident for it to save in IFM. The IA Request will appear on the map 
at the same location as the incident icon.  
 
Respond to an IA Request:  

 The IA Request will flash when Acknowledgement is required (flashes for ALL users with the IAR icon 
overlay enabled).  

 How to I know the Request is directed at me?  The icon flag should indicate who should respond (eg: 
Palmer TB vs. Statewide Tactical). The IAR will also ding audibly for users who's User Preference match 
the Responsibility field of the IAR (e.g.: if the IAR is being sent to Statewide Tactical, the IAR will ding for 
those users only). 

 Acknowledge the IA Request by hitting the Acknowledge button 

 Change the Responsibility field to reflect the recipient of your response (e.g.: Responsibility should not 
remain as you).  

 Fill in the Task Status panel with any IFM Resources - (see below) 

 Change the Resource Task Statuses as necessary 

 Change the IA Request Status as necessary 
 
Resource Tasks: 

 Add Resources: The resource Task Status will default to Pending (remains Unassigned to the incident).  
o Drag & Drop: users can drag resources from the Resource List and/or Quick Picks to the table 

o Hit the Add  button to add a new row to the table. Choose a resource from the dropdown or 
type it in the field + Enter. Fill in any extra information. 

 Remove Resources: Hit the Remove  button to remove any rows that were added by mistake.      
Note: do not remove rows when resources have completed their task, simply adjust their Task Status. 

 Task Status:  
o Pending: a resource is not actively working this Request, but is slated to 
o Assigned: a resource is actively working this Request. They will be Assigned to the Incident that 

is associated with this IA Request. 
o Cancelled: the resource is no longer required to attend to the Request. If the Task Status for the 

resource was In Progress, choosing Cancelled will Unassign from the incident.  
o Completed: the resource has completed its task for this Request. If the Task Status for the 

resource was In Progress, choosing Completed will Unassign from the incident. 
o UTF: the request for this resource can not be filled. If the Task Status for the resource was In 

Progress, choosing UTF will Unassign from the incident. 

 Resources can be added to multiple IA Requests at a time, though they can only be 'In Progress' on one.  

 Already Assigned Resources: If adding a resource that is assigned to a different incident, a Task Status of 
'Pending' will not impact the resource. Once the Task Status of the Resource is changed to 'In Progress' 
the resource will now be assigned to the IAR's incident. The resource will automatically be 'Completed' 
on the previous IA Request.  

 Task History: the Resource Task table is meant to reflect what occurred on this IA Request. Change the 
IA Request Status or the Task Statuses to reflect the workflow. Only remove table rows if added by 
mistake. 

 
Complete, Cancel, and Deny the IA Request: 
Once the IA Request is no longer In Progress, select the appropriate IA Request Status.  
Selecting Complete, Cancelled or UTF will:  

 adjust all resources in the Task table to have the same Status 



  IFM 2015 User Manual 65 

 

Selkirk Systems Inc. 2015 R1   03.13.2015 

 Unassign them from the IA Request's incident 
Note: If a resource is 'In Progress' on an IA Request 1 and it is put 'In Progress' on the next IA Request 2, it will 
automatically change to 'Complete' on IA Request 1 (re-assigned).  
 
IA Request Beeping/ Audible Alarm: 
Audible alarms are based on the Responsibility field of the IA Request. If the 'Responsibility' is directed at your 
station (User Pref), the audible alarm will beep every 15 seconds. If the Responsibility field is changed, the 
beeping will be directed at that station (anyone who has their User Pref to that station).  
To hear audible alarms for your station/ Org, ensure that the Beeping menu is enabled as well. 
 
IA Request List: 
The IA Request List displays all of the IA Requests for the current fire year.   
 
IA Request Tree: 

 Active: Requested,  In Progress, any Unacknowledged (Cancelled, Completed, UTF) 

 Inactive: Cancelled, Completed, UTF 

 
Report: 

 The IA Request Report displays the current snapshot of the IA Request 

 
 
 
 
 
 
 
 
 
 
 


